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IMPORTANT

The product descnibed in this manual and products for use with it are subject to
continuous development and improvement

This manual 18 provided to you frec of charge and s intended only to assist the
reader in the use of the product and the information contained in this manual
and literature provided with the product is given by AMSTRAD in good faith
AMSTRAD MAKLS NO WARRANTY OF ANY KIND, LITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO. THE IMPLIED WAR-
RANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE AND AMSTRAD ACCEPTS NO LIABILITY FOR ANY LLOSS OR
DAMAGE ARISING FROM THLE USE OF ANY INFORMATION PROVIDED
OR OMITIED.

This manual may include 1echnical inaccuracics or typographical errors
Changes are periodically made to the information contained herein: these
changes will be incorporated in new editions of the publication. AMSTRAD
may make improvements and’or changes in the product described in this
publication at any time but does not undenake to notify customers of these
changes.

The products referred 1o herein are not designed and should not be used for. oe
in connection with, hife critical funcnions or any activity in which an error or a
fault may result in physical damage or injury to person(s) and AMSTRAD does
not authonse such use

You must carcfully read these instructions and all other literature provided with
the product

EXCLUSIONS OF CONSEQUENTIAL LOSS
IN ANY EVENT, AMSTRAD ACCEPTS NO LIABILITY FOR ANY CONSE-
QUENTIAL LOSS OR DAMAGE ARISING FROM THE USE OF TS
MANUAL OR PRODUCTS USED WITH IT OR ANY INFORMATION
PROVIDED IN OR OMITTED FROM THIS MANUAL INCLUDING, BUT
NOT LIMITED TO, ECONOMIC OR FINANCIAL LOSS, DAMAGE TO
PERIPHERAL EQUIPMENT OR PRODUCTS. LOSS OF USE, PRODUCTIV-
ITY OR TIME.
Nothing in this document i3 intended to exclude or restrict any of the consum-
cr’s rights where to do 30 would be illcgal
Neither the whole nor any pan of the information contained herein, nor the
products described in this manual may be adapied or reproduced tn any material
form except with the prior wniten approval of AMSTRAD plc
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Published by AMSTRAD plc

The PcW16 Software and Manual are copyright
© Amstrad plc and Creative Technology (MicroDesign) Ltd 1996

The Spelling portion of this product is based on Proximity Linguistic
Technology

THE PROXIMITY/AMSTRAD LINGUIBASE © Copyright 1995 Amstrad plc
© Copyright 1995 All Rights Reserved Proximity Technology, Inc

All correspondence relating to the PcW 16 product or to this manual should be
addressed to:

Amstrad Direct Ltd

2 Marsh Road

Wembley

Middlesex
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CHAPTER 1:

SETTING UP
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Setting Up

Before you begin...

In order to sel up your PcW 16 system, you will need a clear. dust-free arca
on a desk or table that 1s at lcast 41t wide and 3t decp

When choosing a position for the system...
Make surc that all the cquipment is installed close to, and within casy
access ol the clectrical mains supply socket.
Make sure that the equipment is NOT situated ncar an antificial heat
source, such as a radiator, near a water supply. in direct sunlight, nor ina
humid or damp atmosphere. These clements can damage your system and
destroy data. Avoid a location where the system will be exposed to dust,
din, vibration, excessively high or low temperatures or rapid changes in
temperature. The operating temperature specification for this system is
between 10°C and 35°C. Do not put the system near other clectrical or
Imagnetic equipment

Legal Obligations for Employers
I'here are certain mimimum health and safety requirements which relate to
warking with display screen equipment. These requirements arce set by the
EC Directive (90 270/EEC) and employers must comply with them

General Health and Safety Advice
In order 10 ensurc enjoyable and safe use of your system. il i1s important
that you give full consideration 1o ergenomics:

*  Always sit comfonably at an appropriate height and distance for using
the equipment

*  Position the screen 1o suil your needs and adjust the brightness and
contrast contruls to ambient conditions 1o avoid any discomfort.

*  Placcthe heyboard in a comfonable wosking position 1o avoid fatigue
in the armis or hands

*  Ensure there 1s adequate working space
*  Choose an adjustable desk or table so that you can position the screen
appropriately.

*  Ensure that there s satisfactory hghting: taking into account the type of
work and user’s vision requirements. Avoid disturbing glare or
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Setting Up

teflections. Ensure there s no distracting or distutbing noise or excess
heat which could cause discomforn

*  Activities should be planned so that daily work on a display screen is
periodically interrupted by breaks or changes of activity. As with all
clectronic equipment. take regular breaks to avoid eyvestrain and to rest
your hands and arms. It is also wisc to consider purchasing optional
filters and screens.

important Safety Notes
When the PcW16 is switched on, do not obstruct the airflow around it
Vents are located on the unit, so the arca around it must be kept clear: that
is. do not place books, papers, or any other objects undemncath, immedi-
ately in front of,, to the side of, or behind the unit. If the unit is obstructed,
the air flow will be interrupted which will prevent the unit from being kept
coul

WARNING:
DO NOT CONNECT YOUR PcW16 TO AN “IT” POWER SYSTEM
An “IT” power system is a power distribution syslem has no direct connec-
tion to earth, The exposcd conductive parts of the clectrical installation
must be carthed
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Setting Up

Setting up your PcW16

Step 1
Unpack the boxes and check you have the following items:
«  PcWI6 unit
«  Keyboard
. Mouse
*  This manual
*  Rescuedise
*  Pnnter and Printer manual (optional)

The Rescuce disk will be required during the initial setup process, but once
your PcW16 is up and running. you will not need to usc it unless something
goes wrong. For further explanation about this disk, please read the
Troubleshooting scction in Appendix G of this manual.

7 - ’l ~
g" ‘- Lf
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Step 2: Keyboard and Mouse
Conncct the Keyboard and the Mouse, as shown. The keyboard should be
placed in front of the screen unit. The mouse should be placed on the right
of the keyboard (or the left if you are left-handed), in an arca where there is
space to move the mouse around. The surface should be clean (to prevent
clogging up the mousc mechanism with dust and din) and smooth (so you
can move the mouse casily). You need an arca of about 8 by 10™
(20 cm x 25 cm). A “"mouse mat” provides a good surface, and helps keep
the mousc clean - these are available from most computer shops.
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Step 3: Printer
Connect up your Printer as shown. [f you do not have a printer, ignore this

step - the PeW 16 will work without a printer attached.

Step 4: Switching On
Connect the PcW 16 to the mains supply. and switch on the power.

=
81 M,T, Brghiwrsa
Corwvent

First. the screen displays a message asking you to insert the Rescue Disc
into the disc drive. Insert the disc, then press the Green ¢ key
The system will spend a few minutes loading some essential information

from the disc, before displaying this opening screen:

[ f—:
| e | ety | e |

If you cannot sce the screen clearly, adjust the contrast and brightness
controls as indicated on the diagram above.

The first ime you use the PeW 16, leave it connected and switched on at the
mains for at lcast 2 hours. This will charge the internal NiCad battery.
This battery is used to maintain the PcW16's internal date and time when
there 1s no external power (for example during a power cut, or if you
disconncct from the power supply).
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PLEASE NOTE:

I'he rest of the steps in this section require that you type information into
your PcWi6. It does not matter if the information you type Is incor-
rect: all the information can be re-entered correctly later on, and no prob-
lems will result from incorrect information. If vou think you have made a
mistake, it docs not matter: just carry on following the steps

Step 5: Setting the Clock and Calendar

Now that your PeW 16 is up and running, the first thing you must do is set
the Clock. To do this, you must enter the Time and the Date, by following
the instructions on the screen

Sctting the Date

Notice how the instructions are displayed in boxes, which scem to appear
over the top of the main screen. These boxes are called "Dialogs”, and you
will scc a lot of them when using the PcW16's programs. The first is used
1o sct the Date.

I m.r;]"[.t»cu-]._‘"[ V1P V] ’

Notice how the dialog stself tells you what to do. The line of white text on
a black background 1s an instruction, telling vou exactly how to enter the
information required

Please type tuday's Datr s the tormat 11 Bt WM™ then prost the Lovian o Ry

When yvou type the date, you should see it appear in the white box in the
middle of the dialog. As soon as you start typing, the existing date 1s
clearcd, and the number you type appears in its place. You must type the
date in the correct format - for example, if the date 15 the 2nd June 1996,
you should type "02/06/96", 50 that the screen looks like this:

o TV G

When you have tvped the date, you must press the Green / key to tell the
computer that you have finished entering information in this dialog
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Setting the Time

After you have pressed the Green / key, the PcW 16 shows you another
dialog which asks you to enter the Time. Type the correct time, using a
colon to sepanate the hours from the minutes. For example, if the time is
9:30pm, you should type "21:307, so that the screen looks hike this:

. ) Ecea

Now, once you have entered the time, you could press the Green  key to
tell the PcW 16 that you have finished with the dialog, but this time, instead
of pressing a Key, try using the mouse.

Clicking with the Mouse - an Introduction

Instead of pressing /. you can use the mouse to finish off the dialog
When you moye the mouse across your table top. a little arrow pointer
moves on the screen - move the mouse left or night., and the pointer moves
with it. You can use the mouse pointer to point at objects on the screen,
then you can press the left mouse button to activate these objects

If vou have never used a mouse before, have a look at the following dia-
gram 10 scc how to hold it:

This shows how a nght-handed person would hold the mouse, and press the
left button using their index finger. (If you are left-handed, you can switch
the mouse buttons around. When you have worked through the Beginner's
chapter, look up “Left-Handed” in the index to this manual for instructions
on swapping mouse buttons.)

Now. to complete the Time dialog. try pointing with the mouse at this

“OK Button™:

IMis is called a button because you can “press” it - move the mousc until
the on-screen pointer 1s over the button, then press and releasc the left
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button with your index finger. As you press the button, you will see the
button become highlighted 1o show that vou have clicked it.

]

This method, called "Point and Click®, is used by all mouse-operated
computers. "Chcking On” something means pointing at it and pressing
then releasing the mouse left button, and many instructions in this manual
supgcst that you click on screen buttons and other objects.

Two Reassuring Notes

*  Using a mouse can be a little wricky at first, but it becomes much casier
with pracuce.

= Although it is often uscful to be able to operate the computer using the
mouse, you do not funve 1o use 1. You can always operate your PcW 16
using only the keyboard if you wish. In this case, instcad of clicking on
the button, you can simply press the Green ¢/ key, just like you did with
the first dialog

Step 6: Entering Your Name and Address
Next, you have to enter your own details into the PcW16. In order to
construct your personal headed stationery, the system needs to know your
name, address, and other details. 1t asks you to enter cach hine of your
name and address separately, in a series of dialogs - after you type cach
picce of information, press the Green ¢ key to enter it

Using Upper and Lower Case Letters - the Shift Key
When entering your name and address, bear in mind the following points:
Your lctterhead will look best if you use upper and lower-case letters, hike

this:

[Cransy man ]
Tg | Totypeacapital leticr, hold down onc of the Shift keys while you
( \ press the letter. The Shift keys have wide arrows printed on them.

Leaving Lines Blank and Entering your Post-Code

You can always lcave a line blank by just pressing the Green / key without
typing anything. You can enter up to five lines of address, plus an extra
line for your postcode - if your address only has three separate lines, just
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press / to leave the fourth and fifth lines blank, then enter your postcode
when prompted to do so like this:

T | Goaen o hy

Step 7: Choosing a Printer
In order to be able 1o Print from the word-processor and spreadsheet
programs, your PcW 16 must know which type of printer you have. If you
have bought vour PcW 16 and printer together, you may have onc of the
printers shown in the imitial hist:

If so, select your printer by pressing the [+] key until the correct name is
highlighted, then press /.

IT your printer is not in the list initially displayed, press the [+] key three
times 1o reveal the list of "Other Printers”. Continuc pressing [+] 10 select
vour printer from the longer list, or to sclect the printer type which best
matches i, then press /. For more information about different printers and
printer types, and how to work out the best match, see appendix C.

Once vou have chosen a printer, your PcW 16 will configure its “fonts®, or
typefaces, 10 suit the printer you have chosen. This process can take a
minuic Or two.

Step 8: Setting a Startup Option
This option 1s not essential to the PcW 16's operation - for the moment, just
press ¢ to accept the default sctting.

Page 16 Amstrad PCWIé



Setting Up

The Desktop

The initial installation process is now finished, and you should sce the
maimn PcW 16 startup screen, which looks like this:

josn \i} tup Demas Mylg |

Amstrad

ADDRESS BOOK
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This screen is called the Desktop, and stis the main screen from which you
choose which PcW 16 program you want to use. In future, when you
switch on your PcW 6. this is how the screen will appear

Switching your PcW16 On and Ofi - the Standby Button
When you finish a session with your PcW 16, you should always switch ofT
using the Standby button. This button glows red when the PeW 16 is in
Standby mode, and green when the computer is switched on. When you
switch off, it may flash for a shont time, to indicate that it is saving any
unsaved work, before tuming red. DO NOT SWITCH OFF THE
MAINS SUPPLY WHILE THE STANDBY BUTTON IS GLOWING
GREEN OR FLASHING - always wait for it to change 1o red before
switching ofT the power, or the automatic saving system may not work

properly
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What to do next...
We suggest that yvou begin by reading the rest of general information given
in this chapter, then follow the step-by-step instructions in the Beginner's
chapter to get started.

How to Use this Manual
We strongly recommend that you kecp this manual handy - 11 can save you
a great deal of time and trouble in the future!

The Beginner's chapter is a brief introduction to word-processing, and a
walk-through of some of the programs supplicd with your PcW16.

Ihe Refercnce chapter contains a full explanation of every function and
program in your PcW 16 system. If you run into trouble with a particular
program or command, look up the command name in the Index to find the
explanation of that command in the Reference chapter.

The Appendices contain extra information which may be of technical
interest, but which is not essential for general use.

The Glossary is a hist of "jargon” tcems, with an explanation of cach term
in plain English

The Mouse

The manual gives instructions for using both the mouse and the keyboard,
but is generally assumcd that you will use the mouse where appropriate.
For some operations, specific key-by-Key instructions arc not given if the
operations can be done more casily with the mouse. If you do not want 1o
use the mouse at all, you should read the tips on using the keyboard, which
arc included in appendix D.

References to Keys on the Keyboard

The manual uses "square brackets™ to refer to specific keys on the PcW 16
keyboard - for example, [GG] means the G key, [Stop] means the STOP key
(at the top left of the keyboard) and [Space] means the Space Bar, Some
keys have only symbols printed on them, but are referred 10 by name:

[Shift) the Shift keys. which have {} symbols printed on them;
[Space] the Space Bar,

[Retum] the Return key, which has a gJsymbol printed on 1t;
[Tab] the Tab key, which has a "'_':’ symbol printed on 1t
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Key Combinations
Sometimes you have to press combinations of keys - for example when you
tvpe a capital letter by holding down the [Shift] key and press a fetter. In
addition to [Shift], there are two other keys, [ Tasks)] and [Ctrl] (or "con-
trol™), which operatc in the same way as the [Shift] key - you hold them
down while pressing another key.

This manual indicates that vou should hold down one key while pressing
another by using the “+~ sign. This mecans that when the manual says
“Press {Tasks]+[Stop]”, it mcans "press and hold down the [Tasks] key, and
while holding it, press the [Stop] key™.

Floppy Discs
Your PeW16 uses 3.57 1.44Mb "HD" type floppy discs:

— =

You will not require these immediately because the PcW |6 has an intemnal
storage sysiem called the Cabinet. However, you will need to make backup
copics of your work on floppy disc, so we recommend that you buy a box
of suitable floppy discs - these are available from mast computer shops or
mail-order supplicrs.

Hel
l';'hcrc 1s a single hine of "Help” information displayed across the bottom of
the screen at all imes. You can also press the [HELP] key at any point 1o
see n more detailed Help information screen. The information displayed on
the help screen is "context-sensitive™ - this means that it changes as you usc
different programs and commands, so that it always displays information
which is relevant to whatever you are doing at the time.
The full help screens also include an “Index™ button, which you can click ta
get Help on a particular topic.
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The Screen Saver
The screen of any computer can be permanently marked of one image is left
on 1t for a long time. To prevent this happening, the PcW 16 has a "Screen
Saver” system. If you Icave your P¢W 16 for 10 minutes without touching
the keyboard or the mouse, the screen saved comes into operalion - the
screen will clear and a moving “starficld” effect will be shown. As soon as
vou touch the keyboard or mousc, the original screen contents will be
restored. and you can continue working.
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CHAPTER 2:

BEGINNER’S GUIDE
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1: The Desktop
This 1s the opening screen of your PeW 6, called the Deskiop
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Ihe screen shows the six different programs which are supplied with your
PcW16. Thesc are

. The Word-Processor
. The Spreadsheet

. The Address Book

. I'he Diary / Alarm

. T'he Calculator

. I'he File Manager
You can choose any of these six programs by clicking on the relevant
button. (Remember that Clicking On something means pointing at it with
the mouse, then pressing and releasing the mouse left bution.)
Alernatively, you can press the indicated key - F1 for the Word-Processor,
F2 for the Spreadsheet cte. There are 8 F-keys altogether: they are plum-
coloured, and are located in a row across the top of the keyboard.

You can return to the Desktop from any program by pressing the [Stop)
key - this the plum-coloured key located at the top left of the keyboard
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2: The Word Processor
Now it’s time 1o create your first document. The purposc of this section is
to show just the most basic use of the word processor. You will start the
word processor, give your new document a name, type in some text, then
print the document. You will then go back to the same document. make a
few changes to it, then print it again,

Step 1: Starting and Naming a New Document

At the main Deskitop screen, click on the WORD PROCESSOR button, or
press the [Fl ] key.

WORD-PROCESSOR

[ oxos | [cascnix] [_lgur_ | "' 'f."

Type in a name for your document - you will sce it appear in the box in the
middle of the dialog as you type. You can type up to 32 characters, includ-
ing spaces. (Note that there arc a few characters., such as the question-
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mark, which you are not allowed to use in document names. If you try to
type a disallowed character, the character will not appear.)

For this exercise, you are lyping a letter to a Mrs Butcher, so type in
“Letter 1o Mrs Butcher”™. (Always use a name that will be meaningful to
vou later). If you make a spelling mistake you can use the [«=Del] key to
delete what you have typed and start again.

When you have finished typing the name for your document, click the
dialog's OK button with the mouse, or press the Green  key.

Choosing a Template

Next, you must choose the Template on which the new document is based.
A Template is a ready-made document style, and there are five different
templatces supplied with your word-processor. As you are typing a ketter,
you will nced to select the Letter template: this template automatically
prints your namc and address at the top of the first page, 10 save you
having to type it every time you write a new lctter.

Click the mouse on the words "Letter template™ in the list of templates, then
click on the OK button. (With the keyboard, press the T4 keys 1o highlight
the name "Letter template”, then press the Green / key.)

Note: whenever you start anew document, you always have to sclect a
template. If you just nced a plain document, sefect the “Blank™ template.
You can make your own temnplates, or you can customise the supplied ones.
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Step 2: The Word Processor Screen and the Cursor
Y ou should now see the word-processor’s Document screen, which already
contains your name and address at the top of the screen, and some other
standard text for letters - this text is already present because you selected
the Letter template.
When yvou type in a word-processor, the characters you type appear at the
Cursor. This is a Nashing bar which you can move around the word-
processor screen using the Cursor Keys - the Cursor keys are the group of
four keys with arrows printed on them:

gug

To begin with, the cursor appears at the beginning of the document, just to
the lett of your name at the top of the screen

Tha Carsor

Before you start typing the text of your letter. you nced to move the Cursor
10 the point where you want this text 1o appear. You can move the cursor
using the cursor keys, or using the mouse. Try pressing [4]10 move the
cursor down the screen.

With the mouse, move the pointer to the place where you want 1o stant
typing, then click the left mouse button - you should see that the cursor
moves to the position of the mouse pointer.

Some General Notes on Typing
If you have not used a word processor before you need to get used 1o the
feel of the keys., as well as lcarn what alf the keys do. When typing, a hight
touch is required, if you hold a key down for 1oo long it will be repeated on
the screen until you release it If you find 1t more comfontable, angle the
keyboard using the flip-down legs. To make your typing look professional
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the spacing should be correct; one space after a comma, colon or scmi-
colon and two spaces afier a full stop.

Typing Capital letters

Vo type a single capital letter, hold down one of the [Shift] keys then press
a character key. If you want Lo type a whole word or more in capitals.
press [Caps Lock] once, then type the text. When you have finished press
[Caps Lock] again to switch the capitals off. While the Caps Lock is ON,
the Caps Lock indicator at the top right of the keyboard is lit

Starting a New Line

When you num out of space at the end of 2 linc, just carry on typing - the
word-processor will automatically move the next word onto the next line.
This is called “word wrapping™. For your word processor to distinguish
where one word finishes and another starts, you must type a space. Don't
torget to put a space after a comma, and two spaces after a full stop.

Starting a New Paragraph

When you have fimished a whole paragraph, press the [Return) key (the key
with the d symbol printed on it). This tells the word-processor that you
always want to start a new line at this point in the text

Step 3: Typing the Text of your Letter
To begin typing your letter, move the cursor to a position in between the
"Dear™ and the following comma, about haltway down the screen on the
leR. Remember that you can move the cursor using the arrow Keys, or by
pomting and clicking with the mouse. Now type "Mrs Butcher™, so that the
beginning of the letier reads

Decar Mrs Butcher,

Neat, mave the cursor down onto the next line by pressing { L], then type
the text of your letter. For the mmoment, it does not matter what you type,
but yvou could experiment with word-wrapping by typing more than onc
linc. Youcould also try pressing [Return] 1o start a new paragraph.

Step 4: The Stop Key
When you have typed the letter. press the [STOP] key 10 tell the word-
processor that you have finished. The document will be stored automau-
cally under the name you gave it. and you can go back and edit or primt it
al any time.
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Step 5: Printing
When you press stop. you return to the word-processor opening screen
I'his ime, you want to Print the letter vou have just typed, so choose Print
by chicking on the Print button, or by pressing the Green key.

Now, the screen shows a dialog which lists the documents you have stored,
and allows you to choose onc to Print.

. LR
34008
2308/

fLars

Usc the T keys to move the highlight over the "Lctter to Mrs Butcher”™ (it
may be the only document in the hist), or click on it with the mouse, then
press the Green / key or click on the "OK /" button with the mouse.
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Atter a few moments, the document will appear on the screen, then you wall
sce this dialog:

e o e
1 . ) S —— : .;i- T —
Make sure that your printer is ready to print, then press / or click on the
"OK /" button to begun printing
If Your Document Does Not Print...

-have a look at the Troubleshooting section in Appendix G. If the PcW 6
reports a particular message telling you why it can't print, this may give
vou a clue. For example, if your printer 1s switched ofT, you will probably
scc a message saying "The Printer may be switched ofT™.

Step 6: Editing a Stored Document
Now that sou have created a new document and printed it, try Editing the
document (ie making some changes to it) and printing 1t again. To do this,
starting from the word-processor opening scteen, click the Edit button, or
press the Yellow key.

EDIT DOCUMINT

-:.r .
el v

Clsh Hevre D
ar Pross

This displays a list of the dJocuments you have stored, just like the Print
bution on the previous page. Choose the Letter to Mrs Butcher from the
list as before, then press / or click on the "OK /7 button.

Y ou should now sec the word-processor screen showing your letter. When
Editing documents, there are two techniques which you will find especially
useful: Inscrting text, and using the Cut and Paste commands.
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Inserting text
T'o inscrt new text into an existing document, just position the cursor (using
the mousc or the cursor keys as explained carlier), and type the text. Any
cxisting text wall move to the right or down the screen as you type. 10 make
room for the new text.

Reformatting and Re-Paginating

Note that when you Insert text, the layout of the text on the screen may
appear to change in a way which you did not intend. This rearrangement 1s
not permanemt, and the text will be reformatted correctly when you stop
typing for a few seconds, or if you press the Green  key.

It you want to check the layout of the whaole document, press {Crel]+{T] to
force the word-processor to correct any anomalics in the document display
- this formatting process is called "Re-Paginating™. The wosd-proscssor
does not re-paginate automatically. because repagination can take a fow
sweconds, and you cannot type while it is in progress.

Marking, Cutting and Pasting - the Scratchpad
If you want to move a section of text from one part of the document to
another, you could delete and re-ty pe it. but this would be very time-
consuming. The word-processor allows you to manipulate a section of
your document, by providing two "Markers™, which you can place at the
Start and the End of your sclected section of teat
IT you place the Start marker at the beginning of your selection, then place
the End marker at the end. the selected section is highlighted, so that it
looks hike thas:

Thas section of teat is mat selectrd RE R

LR TE N This section 13 pot selected
Once you have selected a section of your document, vou can remove the
sclection and place it in a temporary storage arca called the Scratchpad. In
this example, you will move a section of the text from one place in the
document to another using the Scratchpad

Placing the Markers with the Keyboard

In your example letter, moving the cursor to the beginning of a section you
want to moeve (it doeso’t matter which section you choose), then press
[Cred]+[M]. (Remember that this means "hold down the [Cirl] key and
press [M]) Now, move the cursor to the end of the section you want to

— B
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move, and press [Ctrl]+{D]. The markers themseclves are not shown on the
screen, but you should see that the section of text between them is now
highlighted.

Placing the Markers with the Mouse

Instead of using the kcyboard, you can sclect a section of text by moving
the mouse pointer 10 the beginning of the section and pressing the middle
button, then moving the pointer to the end of the section and pressing the
right button. The section should then be highlighted

Cutting Text to the Scratchpad

To remove the marked scction and store it temporanly on the Scratchpad,
press [Curl]+ [ X]. (To Cut with the mouse, you must choose the Cut
command from the Edit menu - sce Menus and Commands at the end of
this section for more information. )

Pasting Text from the Scratchpad

T'o put the text you have Cut back into your document in a different place,
first move the cursor to the position where you want the text to appear.
Next, press [Cirl]+[ V] (or choose the Paste command from the Edit menu).
The text is inserted at the new position.

Note that after you Paste, the text is not removed from the Scratchpad, so
you ¢an Paste the same text again somewhere clse if you want to. Old text
is only removed from the Scratchpad when you Cut (or Copy) a new picce
of text onto the Scratchpad. The Scratchpad can only hold one piece of
tex!I at once.

Saving your Edited Document
Omnce you have made the changes you want to make to your document, you
can press [Stop] (or click the “STOP” button with the mousc) to save the
new version. To print it, choose the Print button as described tn step S.

For More Information about the Word-Processor...
That concludes the Beginner’s walk-through of the essential word-processor
functions. but the program is capable of a great deal more than we have
scen so far. For more information about the word-processor’s capabilitics
and how 10 usc them, plcase sce the Word-Processor section of the
Reference chapicr.
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3: The Address Book

The Address Book allows you to enter and store names, addresses,
telephone numbers and other information, just like an ordinary address
book. From the Desktop screen, to use the Address Book, click the Address
Book button, or press the [F3] key.

ADDRESS BOOWN

The Address Book screen looks hike this:

| Josn ;_ﬁnl Beds Melp 1

le Dglate
fhe dogtod T wiry
Clh bove o poves

Addreaan
Addreoss 2
Addretss 3
Addrese 4
Addronn §
Potl Code
Tel 8
et 2
Tel 3
Tel 4

l mail

Sutes

Yo te® o ey i Pl ol 5 @ET T uoe T NS seiai® P A B Lsl. T iredin ¢ ~ow arly, Bl "ew ™.

Each entry in the book contains sixteen different “ficlds™, or categorics of
information. The names of these fields are shown down the left edge of the
Entry pancl, on the left of the screen. In this example, you will create a
new entry in the Address Book.
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Adding an Address Book Entry
When you first use the Address Book. it 1s empty, so no entnies arc histed
o create an entry, click the "Add New Entry™ button at the 1op of the
screen, or pross the Blue key.

Now type a Surname. You will see the letters appearing in the "Namel”
section of the Entry panel as you type. We suggest that vou use the Name!
ficld for surnames. and the Name2 ficld for first names. If you make a
mistake you can use the [« Del] key to delete what you have typed
Moving to the Neat Field

When you have typed the surmame for your new Entry, press [Return ) (the
hey witl the @ symbaol printed on it) to move to the neat ficld, then type
the first name for your Entry. For example, if you were creating an entry
for "Fred Bloggs™, vou would enter the names like this:

"fesss Qfiver [nmis

fa Add
A nae §atry
Clieh hoore o peooe

You can type up 1o 63 characters into cach ficld. though not all the charac-
ters may fit into the Entry panel display.

Continuc typing the entry ficlds and pressing [ Return ] until you reach the
bottom of the Entry panel. 1t you want to leave any of the ficlds blank,
sunply press [Returmn] without tvping anything

When you press { Return] in the last ficld. called Notes, the Entry wall
appear n the list on the Addresses pancel.

Adding more Entries...

T'o add another entry, chick the Add button again, or press the Blue key.
Iry adding a few more entries to your Address Book. Note that while you
are typing a New Entry you arc in “editing™ mode. As soon as you change
from editing mode by clicking on another name in the list on the right, or
sclecting a command from onc of the menus, the Entry you are typing is
saved and appears in the list of Addresses.
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Editing an Address Book Entry
Once you have added two or three entries to the book, you can try changing
(or "Editing") one of the entrics. To edit the Fred Bloggs entry, for exam-
ple, click on "Bloggs, Fred™ in the Addresses panel, or use the T4 keys to
highlight it:

When an entry 1s highlighted in the hst, 1ts ficlds are displaved in the Entry
pancl, with the text cursor in the "Name1” ficld. Youcan change the
Name! contents by typing extra lctters, or deleting.

To cdit the contents of one of the ficlds, click on the field you want to
change. or press [Return] until the text cursor is flashing in the ficld you
want to change

Leaving the Address Book Program
To save your Address Book and retum to the main Desktop screen, press
[Stop] or chick on the Stop button at the top left of the screen.

psiop
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Using the Address Book Fields
Y ou can usc the different Address Book fields for whatever information you
want - just because a ficld is called "Tel 47 docs not inean that you can only
wsc it for storing a telephone number. However, the standard way o use
the ficlds 1s as follows:

Namel
Namne2
Name3l
Tule
Address!
Address2
Address3
Addressd
Addresss
Post Code
Tell

Tel2

Teld

Teld
Emanl
Notcs

Sumame

First Name

Maddle or Other Name

Mr, Ms. M ctc

House name, or number and street
Number and streel, or Arca

Foavn

Coumy or State

Country or other

Postal or Zip code

Home telephone

Work Telephone

Mobile telephone

Other telephone or Fax

Electronic Mail or Internet address
Any extra information you want to add o the entry

For More Information about the Address Book...
That concludes the Beginner’s walk-through of the essential Address Book
functions. For full details of the Address Book commands, please sec the
Address Book section of the Reference chapier.
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4: The Diary/Alarm

The Diary/Alarm program allows you to keep a diary of appointments. and
to set "alarms” which display a message on the screen at the appointed
tme. From the Desktop screen, you can choose the Diary program by
clicking the Diary button, or pressing [F4]

MARY - ALARM

The Diary/Alarm screen looks like this

I-:.;:_-D.:lﬂ Yoo Il;;i-nﬁluu-!\ )

lrw.-._ . _";b 1

‘l Orlees
be SLolsted F=ley
{lah bhore ar powoe

1996

Vuguet

", ol A FOm MMPRATREl s B a0 MRy ey, e = T™e AR
—

Ihc Appointments pancl (right) works rather like an ordinary diary. Itcan
show a single day. or a wholc week

The Calendar pancl (left) indicates which days have appointments, and 15
used 1o set the day (or week) which is displaved in the Appointments pancl
The current day (as sct by the PcW 1 6's inteenal clock ) is always shown in
black

The Clock pancl (bottom left) shows the current Tune and Date

Page 36 Amstrad PCWI6



Beginner's Guide

Adding a New Appointment
To make an new appointment in the Dhary, click the Add button, or press
the Bluc key

o Add BLUE
A New Entry
Click here or press

Now you have to type the Message for your appointment. Appointment
messages can contain up to about 63 characters, though not all of these
characters may be visible on the screcn at once. To store the appointment,
press the Green / Key.

Y ou should now sce the appointment message (or the beginning of it)
displayed in the Appointments panel. Note that you have made this ap-
pomtment for "today”™, and that the black highlight for “today”™ in the
calendar is now shaded to show that it contains an appointment. The
illusteation below shows how your screen would look if you were doing this
excrcise on July 31st 1996

NERIT IR R Y
19 96| %7 |18 | 19 20 20

26 |27 | 28
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Editing an Appointment - Setting the Alarm
Now, with the appointment you just made highlighted, choose the Edut
button:

To Edit YELLOW
The Selected Entry

Click here or press

You will again be asked to enter the appointment message, but this ime,
the old message will be automatically displayed in the dialog. We donot
want to change the message, but instead of pressing /. press the [Return])
key, or click the "More I button.

Typing the Time

You will now see a dialog asking you to sct the appointment ime. Entera
time, making sure that you usc the 24-hour format. For example, 09:30am
can be typed as ~9:307, “0930” or “9.30™. L.ikewise, to sct an alarm for
half-past six in the evening, you should type "18307 or " 18:30",

When you have typed the appaintment time, press [Return] or click the
"Morc " button again.

Changing the Date

The next dialog gives you the option to change the appointment date:

b 4 e —

Assume that we need to move the appointment to "tomorrow™, which is
August Ist. You could simply type "01/08/967, but instcad, ry using the
"Spinner” buttons.

Using Spinner Buttons

[ §] These are the little arrow buttons beside the date display. You can

“spin” the Date up or down by clicking these buttons, or by pressing
the T keys. Press the [ T)] key once or click the B button to move the
date forward by onc day, to August Ist
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Other Alarm Options

Now press [Retumn] or click the "More 1" button. to scc the other alarm
oplions. You can sct your alarm to repeat automatically every day, week,
month or year. You can also choose whether you want the alarm operate -
it you choosc the alarm option, at the appointment tme. your PeW 16 will
display a special dialog containing your appointment message. and can also
sound an audible "beep™. Note that this display of the appointment mes-
sage will happen whatever program you arc using at the time, and if the
PcW 16 ts in Standby mode, 1t will "wake up” and display the alarm

When vou have set the Alanm option, the Diary screen shows the new
appointment:

n Ture Page n

Note that the Appointments pancl now shows the appointment Time, and
displays a little bell symbol to show that the appointment will display an
alarm at the appomnted time

Leaving the Diary / Alarm Program
To save your Diary Appoimmtments and return to the main Desktop screen,
press [Stop] or click on the Stop button at the top left of the screen
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5: The Calculator
From the main Desktop screen, you can choose the Calculator by clicking
the Calculator button, or by pressing the [FS] key.

The calculator works in a similar way to most ssmple pocket calculators.
You can use the mouse to click on the buttons on the screen, or use the
Calculator buttons on the keyboard. The Calculator buttons are located at
the right end of the keyboard, and their special caleulator functions are
printed on them in light blue. (When the Calculator ts running, the normal
functions of these buttons arc disabled )

A Calculation Example
One particularly useful features of the Calculator is the Percent [%] button
For example. you can add 17.5% (the standard rate of UK Value Added
Tax) 1o a number as follows:
* Type the number (cg 50 for 50 pounds)
= Press [+]
* Type the percentage to add (eg 17.5)
* Press [%]
The display now shows 59.75, which ts 50 + 17.5%.

Leaving the Calculator
To leave the Calculator and return to the Desktop, press the Green / key
(or [Stop]). or click the Calculator’s Exit button.

+ Exlt to the
Desktop
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6: Introduction to Storage and Files
All the information used by your PcW 16, from word-processor documents
to typetaces, ts stored in "Files®, Your PcW 16 can store files intwo
different locations: intermally in the "Cabinet”, or extemally on a Floppy
Disc. When you create a new document or spreadsheet, you have to give i
a name - this s the name of the file, and you must also sclect whether to
store the file in the Cabinet or on the floppy Disc

Discs, the Cabinet, and Folders

The Cabinet

The Cabinct stores files using a type of memory chip (called a "Flash-
ROM™) instead of a disc, so it has no moving parts. There 1s a total of
IMb (1024Kb) of Flash-ROM inside the PcW 16, but most of this memory
is used for storing the computer’s operating system, programs, On-linc
Help files, and typefaces.

The most important aspect of the Cabinet 1s that like a disc, it refains its
contents even when the PcW 16 is switched off and its power is discon-
nected.

Floppy Discs

The PcW 16 has a standard 3°5" disc dnve, which can use cither HI) discs
(formatted at 1.44Mb), or DD discs (formatted at 720Kb). HD discs are
reccommended. You should use the floppy disc for creating extra copies of
your documents and files - these arc called "Backup™ copics, because they
can be used as a back-up if something goes wrong with the onginal file.
Note that the PcW 16 disc drive can be used to transter word-processor
files from carlier PcW models such as the PcW9256 and PcW 10, Sec
Importing Documents for mose information

A Technical Note about Disc Formats

The PeW16 uses a disc format which o a variant of the IXOS format
used by other npes of personal computer including the I'C-compal-
ible and Macintosh hpes, so you can use the floppy disc drove to
rransfer files between different machines und programs  Sce appen-
dix F for more information
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Folders and Folder Names

To help you organisc your work, both locations contain sixteen different
“Folders™ - when you create or copy a file, you can choose which tolder to
put it in, and if you wish, you can give your folders suitable names accord-
ing to the ty pe of information you store in them.

F'or example, as we have alrcady scen, when you use the Start New Docu-
ment command in the word-processor, you will see this dialog:

As well as the box in which you type the file name, there arc two other
controls in this dhalog. On the left ase sclector boxes for choosing the
Cabinet or the Disc, and on the right is a "drop-list”™ which allows you to
choose in which folder on the Cabinet or Disc your document will be

crcated.
[ J Cabinet

I'o see how these work, trying clicking on them with the mouse. 1f you
want to access them using the keyboard, sce appendix D for details.

Folder Names

By default, the Cabinet and Disc folders are called "Folder017, "Folder(02"
ctc. but you can rename the folders in the Cabinet or on disc using the File
Manager program. For example, you might usc the word-processor pro-
gram to write personal and business letters. You can keep these documents
scparate by putting them in seperate folders, and you can inake it casier to
find them by naming the folders “PERSONAL”™ and "BUSINESS™.

Note that Folder Names can have a maximum of only cight characters, and
cannot include any spaces, accented characters, or punctuation characters.
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File Names
When you create a document or other type of fife on your PeW 16, you
must give it aname.  This name can be up to 32 characters long, and can

includce spaces, accents, and any other character you can type on your
PcW16 except *, 2.\, /, and |.
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7: The File Manager
It is not necessary to usc the File Manager in the normal course of using
the PcW 16, except for one important operation - backing up your work
from the Cabinct onto floppy disc. It is imporant to make backup copics
of your work, because there are many ways in which the original versions
can be lost or corrupted.
l'o start the File Manager program from the main Desktop, click the File
Manager button, or press {F6].

THE MANAGIR

-

(Bt Hore @
or Prese

When you first run it, the File Manager shows a list of the files in FolderO1
in the Cabinel. You can copy and manipulate these files individually or in
groups - sec the File Manager section of the Reference chapter for more
information on how to do this.

For now, we will usc the File Manager’s Backup command to make a
complcte copy of the Cabinet contents on a floppy disc.

Note that to follow this example, you must use a spare floppy disc. Any
existing information stored on the disc will be lost, so do not use a disc
which already contains important files, and above all, DO NOT USE THE
PcWi6'S RESCUE DISC FOR THIS EXERCISE!

Backing up the Cabinet
Most of the program commands we have used in this chapter have been
accessed by clicking on-screen buttons, or pressing the colourcd key.
However, only a small proportion of program commands arc available on
buttons - most are accessible only through the Mcnu Bar. To use the
Backup command, you will have to select it from its drop-down menu.
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First, choosc the Cabinet menu by clicking on the word Cabinet in the
menu bar, or by pressing [ Tasks}+|C}:

Bachop Cobimat e Disc
Cestore (aldmet treom DiYs

T'his shows the "Cabinet” menu, which contains commands for changing
some of the Cabinet settings. The command we wanti is the onc for backing
up the Cabinet, so press [B] or click on the "Backup Cabinet to Disc”
cutry in the menu.

When you select the command, the program displays this dialog:

[ WARSESL ANY FHES le&(ﬁ‘ﬂﬂliﬁ Dl'h( Wil Bl IO‘H
e —

e

Insert your spare Backup disc, and press /. or click the "OK /° button.
All the contents of the Cabinct. including the System Folder (sce below)
will be copied onto the disc.

For more information about using menus and commands, see the next
section.

Advanced Note: The System Folder

As well as the sixteen folders which you can use for stortng your docu-
ments and files, there is also an extra folder called the "System Folder™.
The System Folder is not normally visible on the File Manager screen
though vou can choose to display it. It is used to store special files used by
the Pc W 16's operating system and programs - these include the files which
contan the Address Book and Diary/Alarm information, the word-proces-
sor's typefaces and templates, the on-line Help for cach program, and other
vital information. YOU SHOULD NEVER DELETE OR ALTER
ANY OF THE FILES IN THE SYSTEM FOLDER UNLESS YOU
KNOW EXACTLY WHAT YOU ARE DOING - scc appendix F for
more technical information about the PcW 1 6°s filing system.
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8: Using Menus and Commands
Almost all the program commands which you have used so far in this
section have been sclected by clicking buttons on the program screens.
However, there are many more commands available in the program Menus,
which appear across the top of the screen in the Menu Bar - if you click on
a menu name, a menu of "Commands” drops down from the name. To
choose a menu command, simply chick on 1t with the mouse..
As an example, let's see how to set the Desktop's Start-up option, which we
alrcady dealt with in Step 8 of the Sewring Up chapter. If you are currently
in onc of the programs, press [ Stop] to exit and retum to the main Desktop.

Choosing a Command from a Menu
The command for setting the startup option is in the Setup menu, which
appears in the Desktop's Menu Bar across the top of the screen:

Prostesr Jatup
u. Set Syvirm Optisne _

e v

Now choose the "Set Startup Options”™ command by clicking on it

$ot [ume & Date .
{ntor Ysor infermation. .
Lalegn

Fristas Zatmp
4t $ystom Optisas..

The screen now shows the Startup Options dialog. We don't really want to
change the option, so click the Cancel button to cancel the command and
retum to the Desktop.

CANCEL
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Using the Menu Bar with the Keyboard
Note that all the menu names in the menu bar, and all the command names
in the menus, have onc of their letters underlined. This is the Key-Letter,
and you can use it (in conjunction with the [ Tasks] key) to activate menus
and commands from the keyvboard, without using the mouse.
For example. the menu-and-command sequence we have just done with the
mousc can be exccuted just as casily from the keyboard, by pressing the
following sequence of keys:
[Tasks}*[S] chooses the Sctup menu, because the S in Sctup is under-

lined. Once the menu is visible...

{S] chooses the "Set Startup Options” command, because the S
in "Sct Startup Options™ is underlined.
X (Red) Canccls the command. If the screen is showing a dialog with

OK and Cancel buttons, you can always choose Cancel by
pressing the Red X button.
So remember, press the [ Tasks] key in conjunction with the imitial (under-
lincd) letter of the menu title to see the menu, then press the underlined
letter in the command name. Note that while menu names always have
their first letter underlined, the underlined letter for a command is not
always its initial letter.

Hot-Keys
ANl commands are accessible by choosing the menu followed by the com-
mand, but many commands afso have their own “hot-keys”, which allow
vou to sclect the command directly.
If vou have followed this Beginner's walk-through n full, you have alrcady
used a hot-key to access a command. In the word-processor, you pressed
[Curl}+[M] and [Cirl}+[D] to mark the start and cnd of a section of text,
then [Curl]+[X] and [Ciri}+{V] 1o Cut this section to the Scratchpad and
Paste it back into 8 difTerent part of the document.
If you go back into the word-processor by pressing |F!] from the Deskiop
(vou will have to Edit an existing document or Start a new onc before you
can start using the program), then click on the Edit entry in the Menu Bar,
you will scc that this menu includes the commands for Mark Start,
Mark End. Cut and Paste. All these commands have their hot-keys listed
beside them.
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9: Using Dialogs
You have already had some practice at using "Dialogs™ - remember, these
arc the boxes which appear in the middle of the screen, and which require
you to enter information or set options. Almost all dialogs can be termi-
nated by pressing the Green / key to confirm the settings, or by pressing
the Red X button to cancel them. Usually, you can also press the [Help]
key for information on what the dialog scttings incan. This section outlines
how to usc Dialogs with the Mouse, which is recommended because the
mousce provides a simple point-and-click method of changing the dialog
scttings. However, if vou really do not want to usc the mouse, you can also
control dialogs using the kevboard. For detailed instructions on this, please
refer to appendix D.

Dialog "Objects”
You have also had some practice at using some dialog "objects” - these are
the components in a dialog, which let you enter information and sct options
For example, you have already learned how to click Buttons, which look

Like thus

and operate Spinners, which look like this:

Appolntment Date : |

As you use more of the PcW 16's programs and commands. you will also
need 1o know how to operate three other imponant types of dialog object.

Lists and Scroll Bars

A Listis simply vertical fist of options, from which you normally need to
select only one - the current sclection is highlighted, and you can use the
mouse (or the T+ keys) to change the selection. For example, when going
through the Setting Up process, you chose from the list of printers which
arc compatible with your PcW16. The full version of this list is:

Canon Bubblejet il3) mode)

Amstrad LQ3500

Epeon Esc/P2 or compatible
Epson 1 or compatible
Epson LQ 1500

IBM X24E or compatible
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'Y In this example of a List, there are more items in the list than will fit
into the spacc available, so the list has a *Scroll Bar®. You can click
bl With the mouse on the scroll-bar arrows 1o see all the items in the list
% As well as operating Lists, Scroll Bars are used in other functions and
objects in the PcW 16 system,
Drop-Lists
A Drop-List 1s a special kind of is1, where you normally sce only the
current sciting  The other scttings you can sclect only appear (or
“Drop Down™) when yon click on the drop-list.
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Once the list is visible, it behaves like a normal list (sce above) until you
select one of its options. It then reverts to its original appearance, with the
new setting visible

Options Boxes

Ihese are the casiest dialog objects to operate: simply ¢lick on the box to
select the option.

COEETTEIONTEEEE (AT
This Option is Sclected This Option is not Sclected

Usually. you can just click on Options boxes to select them. and click them
again to de-select the option. However, some sets of Options boxes are
mutually dependent - in other words, selecting one oplion automatically de-
sclects the other options. For example, when Starting a New Docment in
the word-processor, you can choose whether to create the new document in
the Cabinet or on disc. The document cannot be in both places at once, so
choosing the Cabinct option de-selects the Disc option, and choosing the
Disc option de-selects the Cabinet option. Groups of options which de-
sclect cach other like this are somctimes called "Radio Buttons™.
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By contrast, in the word-processor’s Text Style menu, there are options
boxes for sclecting Bold, 1talic and Underlined text.

As text can be Bold, ltalic and Underlined at the samc time, sclecting one
option docs not de-sclect the others.

Using Dialogs with the Keyboard
For a guide to using dialogs with the Keyboard, sec appendix D.

Conclusion
That concludes the Beginner’s Guide to the PcW 16 programs. Pleasc see
the following Reference chapter for information on using the Spreadsheet
program, and for a complcte description of the menus and commands in all
the PcW 16 programs
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The Desktop
The Tasks Menu

[he Tasks menu s present in all the PcW 16 programs, and in the main
Desktop. It provides a method of switching dircctly from one program to
another.

The Tasks Menu contains entries for all the different PcW 16 programs,
including:

¢ The Word-Processor

Ihe Sprecadshect

I'he Address Book

The Diany/Alarm

The Calculator

The File Manager

In addition, the Tasks Mcnu includes three other important conunands:

Switch Ofi
This command provides a method of switching off the PcW 16 using the
mousc. Sclecting this command has exactly the same eftect as pressing the
Standby switch (see Switching Off). Note that once you select the Switch
Off command. you should not disconnect the mains power to the PcW 16
until the Standby button has stopped flashing. and glows red continuously

Save and Continue
At any point whilc using your PcW 16, you may want to make sure that
your work is saved. You can use this command 10 save all documents and
files, whether in the Cabinet or on Disc. You can also ¢choose this com-
mand by pressing [Tasks]+[F8] on the keyboard.

Run External Program
It is possible to buy or to write other programs to run on your PcW16,
This command allows you to run such extermal programs. You can run
extemnal programs directly from a floppy disc, or from the Cabinet
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The Setup Menu
I'he Sctup menu on the Desktop allows you to alter the information you
tvped in when you first started up the PcW 16, This information includes
your name and address (as used in the word-provessor Templates). and the
type of printer you are using. For details of the Set Time & Date.Enter
User Information and Select Printer commands, please sce the Serning
Up chapler at the beginning of this manuat

Set Startup Options
You can set your PcW 16 up in two different switch-on modes: you can
cither stant up at the Desktop (the default setting). or you can choose to let
the PcW 16 start up in the same condition as it was last switched of V. I
vou choose to Restore the state at last switch-ofT, the PcW 16 will run
whichever program was running when you last switched off, and will load
the document or lile you were cditing if approptiate.

Set Mouse Options
This command displays the following dialog:

Dauble-Click

Some PcW 16 functions respond 1o a double-click of the mouse buttons (sce
the Glossary for an explanation of double-clicking). The "Double-Click
Speed” option allows you to sclect how close together the twoclicks of a
double-click must be 1n order to be recognised.
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Swap Left and Right Buttons

The Mouse can operate in right-handed mode (the default), or in left-
handed mode with the left and nght bution functions reversed. If you are
Ictt-handed and want to hold the mouse in your le R hand, we suggest that
you swap the left/right buttons. 1f the butions are swapped, all "Clicking”
must be donc with the Right butten.

Printer Setup
This command 1s only available if you are using one of the OKI LED Page
Printers. These printers have a number of controls which can only be
accessed from the PcW 16 screen. For o full explanation of these options,
please see your OKI printer manual.

Print Density

The Print Densaty controls the amount of toner which the printer uses on
the paper. Choosing “Dark” printing puts more toner on the paper, which
gives a darker printed result

Paper Thickness

The Paper Thickness option should be set according to the weight of paper
yuu are using in the printer. Using light paper, page printers often “curl”
the paper because of the heat used in the printing process. Sclecting the
"Laght” thickness option makes the printer heat the paper up less, and can
somctimes reduce the curling problem. Set this option according 10 the
thickness of paper you arc using.

Cleaning Page Button

This button prints a single "clcaning page”. If you have just changed the
OKI 1oner cantnidge, or if you find that excess toner is being deposited on
your printouts, you can usc this command to print some blank pages, which
should help to clean out any loose toner in the printer.

If printing a Clcaning Page does not solve the smeanng problem., try
reducing the Print Densaty.

Drum Counter Button

The Drum Counter bution should only be used when you change the
printer’s Drum. When an old Drum nceds changing, this will be reported
when you try to Print from a program. When you fit &2 new Drum, you
must click this button to tell the printer that the new Drum has been fitted.
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Set System Options
This command allows you to change some important aspects of your
PcW16's operating system.
Updating the Rosanne Operating System
This button allows you to load a new version of the PcW16's operating
system from disc. PLEASE NOTE THAT YOU SHOULD ONLY USE
THIS COMMAND IF YOU HAVE BEEN SUPPLIED WITH A
PROPER PcW16 OPERATING SYSTEM UPGRADE DISC. The
documentation which accompanics the disc will provide more information

Dcelete Font

This command allows you to sclect a font which is currently installed in
your PcW16's Cabinct, and delete it. Once you have deleted a font, 1t will
no longer be available for use in the word-processor.

If you do not use onc of the PcW 16 fonts, it may be a good idea to delete it,
as Fonts occupy a large amount of spacc in the PcW 16's Cabinet. Deleting
a Font will make o substantial amount of Cabinct space available for the
storage of files. The two fonts supplicd with your PcW 16 can be rein- !
stalled from the Rescue disc if you delete them, providing that there 18
cnough free space in the Cabinet to hold them.

Plcasc note that If you delete all the fonts in your PcW16's Cabinct, you
will not be ablc to use the word-processor program at all.

Install Font

You can usc this button to add a new Font (or typeface, as used by the
word-processor). 10 your PcW16s Cabinet, so that you can use it in the
word-processor. In order to add a new font, you must purchasc a PcW 16
font disc. NOTE THAT YOU CAN ONLY INSTALL FONTS
WHICH ARE SPECIFICALLY DFSIGNED FOR THE PcW16. Do
not try to install fonts from other types of computer system (such as
Tructype or Postscript fonts), as these will not work with your PcW16.
Pleasc see the documentation supplied with your font disc for more infor-
mation

Screen Saver Delay
This option controls how many minutes of inactivity arc required before the
SCPOCn Saver sysICM COoIMes into operation
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The Word Processor

Typing Text in a Document
When vou ty pe in the Word-Processor, the letters appear at the position
defined by the “Cursor™. If you want to inscrt text at a particular place in
the document, youn must move the cursor to that position before you stan

typing
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Moving the Cursor with the Keyboard
You can move the cursor short distances using the arrow keys. [«-] and
[-»] move the cursor onc character to the feft or right, and [T]and [ 4]
movc the cursor up or Jown the screen by one hine
If you want to move the cursor in larger jumps, you can hold down the
[Ctrl] key. [Cirl]¢|«-] and [Ctel]+[->] move the cursor left or right by a
whole word
You can also move the cursor using the group of keys above the arrow
keys. The [Home] and [End] heys move to the beginning or end of a line,
and the [PgUp] and [PDn] keys move the whole screen up or down the
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document. [Shift]+]{PglUp] and [Shift]+[PgDn] move up and down the
document by a whole page

Finally, {Ctel)+[Home] and [Cirl]+|End] move the cursor directly to the
beginning and end of the document respectively.

Moving the Cursor with the Mouse
To position the cursor using the mouse, simply move the mouse poinler
over the position you want, and click the kefi bution,
I you hold down the [Shift] key while clicking on the editing screen, the
document is scrolled upwards so that the line on which you clicked 1s
displayed at the 10p of the screen,

Moving to the Markers with the Mouse - "Bookmarks”

If you have placed the Start or End markers (see Sclecring Text opposite),
you can move the cursor directly o either marker by holding down [Shift)
and pressing the Centre button (for the Start marker) or the Right button
{for the End marker). Using the markers as "bookmarks™ in this way
provides a usclul short-cut for moving instantly from one pan of the
document to another.
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Selecting Text
If you want 1o alter a section of the documcent (¢ to move a paragraph of
text from onc part of the document 10 another, or to make part of the text
appear in Bold style), you can Sclect the section you want to alter. then use
the commands in the menus to make changes to that section. To select a
scction, you must place the Start Marker at the beginning of the section,
and the End Marker at the end
Omnce a section of text is Sclected, it appears inverted, hike this:

This section of teaf is not selected RETTETTE N ORTE PPN

Many of the menu commands histed below operate only on a Sclecied
section of text, and other commands behave differently depending on
whether any text s Sclected when the commands arc used

This section is pat aelected

Marking Text with the Keyboard
You can Sclect a section of text with the keyboard by placing the cursor at
the beginning of the section and pressing [Ctel]+ [ M|, then moving the
cursor to the end of the section and pressing [Crr]l+[D).

Marking Text with the Mouse
With the mouse, you can sclect a section of text by moving the mousc
pointer to the beginning of the scction and pressing the Centre button, then
moving the pointer 1o the end of the section and pressing the right button
You can also place and remove the Start and End markers by clicking with
the mouse on the Mark button

TThis button is located at the top right of the word-processor screen. 1f no
markers arc placed, clicking it places the Start marker at the current cursor
position. If onc of the markers is alrcady placed. chicking the button places
the other marker at the current cursor position, and if both markers are
nircady placed. clicking the button will de-select the marked area

De-Selecting: Cancelling a Selection
Y ou can cancel a sclection using the “Undo Selection™ command in the Ednt
mcnu, of by sclecting a different arca: each Marker can only be in one
position at a time.
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The Ruler and Tabs

Above the document editing arca 1s a Ruler, so that you ¢can see how wide
vour text will be when it 1s printed.  This width 1s set by the size of paper
you arc using, and by the Margin scttings. The Ruler also acts as an
indicator, showing the Indent and Tab Stop positions:

rl:i-_ [e—— rsert }l;l- - Uado s
piieig tetter o Axalle kel soe fiAl N plall] L4
F o, { ™ Ad Tk - o ) lae el |
N /7 I
Oetault Tab Sicpe
Unar-Defined Tad Siope Fught ingent Indscator
188 Line indent Indcalor
Laft indent IndCator
Marpn Posmbons

Because the word-processor allows you to use different Indent and Tab
scttings in different paragraphs, the Ruler’s Indent and Tub indicators
always show the correct settings for the paragraph which currently con-
tains the cursor. I your document contains paragraphs with different
scttings. you will see the Ruler indicators change as you move the cursor
from one paragraph to the next

Indents

Theee are three Indent indicators, which show the Lefl, Right and Ist Line
mdent scttings of the current paragraph - the paragraph indent scttings are
controlled using the Clhumge Paragraph Format command in the Style
mcnu. Note that the measurements on the Ruler are relative to the Margin
settings for the document as a whole, as sct using the Ser Margins com-
mand in the Document menu. This means that a paragraph with a Left
Indent setting of 0 wall show its Left Indent indicator at 0 on the Ruler, as
shown above.

Tab Stops

The word-processor provides a system of Tab Stops - these are positions
across the page to which you can move the cursor automatically using the

[ Tab) key. Tab Stops arc used 1o align columns of text vertically. Note
that all Tabs i the PcW 16 word-processor are the "Left- Align™ type.
meamng that you can only use them to define the left edge of the column of
text. If you want to align a column of numbers with decimal points, you
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may need to use the "Numbers in Columns® option - sec the Change Texw
Style command later in this chaprer for more information.

There are two types of Tab Stops - the Defanlt Tabs, which are spaced
cvenly across the page, nnd the User Defined Tabs, which are inserted
manually using the Change Tab Positions command in the Style menu.
Default Tabs are displayed as dotted symbols, while User-Defined Tabs are
displayed in solid black. Note that when you add a User-Defined Tab. any
of the Default Tabs to the left of the Tab you have added are removcd.

I you want to add a Usce-Detined Tab Stop. nstead of using the Change
Tab Posimons command, you can simply chick with the mouse on the Ruler,
at the position where you want the Tab to be set. You can also remove a
User-Defined Tab-Stop by clicking on 1t in the Ruler. Note, however, that
when you make changes to the Tab or Indent settings, these changes affect
only the current paragraph

Using Paragraph Styles
You can use the word-processor to type and prant text in a wide vanety of
styles and formats. However, cach time you type a piece of text, it can take
a long tine to choose all the different optiens for font size and style,
paragraph alignment and spacing. and the Tab positions. If you had to
sclect cach set of options individually for cach paragraph of text, the
process could be very timce-consuming.
To make style and format selection casier, the PcW 16 uses "Paragruph
Styles™. A Paragraph Style s just a complete definition of how the text in
a paragraph should look, including the font size and sty le, the paragraph
alignment (lefi-aligned, centred, justified etc), the gaps above and below
cach paragraph, the linc spacing, the Tab stop positions, and soon. When
vou have defined a Paragraph Style by choosing all of these options. you
can thea "Apply~ this whole style to any paragraph, using the "Usc a
Paragraph Style™ command.
Fach document contains 21 Paragraph Styles, and you can give them
names which describe what they do - the names can be a maximum of 12
characters long
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Style Options: Bold, Italic and Underlined Text
At the top of the word-processor screen are three "Style® buttons, for
sclecting Bold, Italic and Underlined text. You can choose any or all of
these Style options simuftancously.

To type in Bold text, simply click the Bold button, or press [CurlJ+[B).
You will soc the button become highlighted, and any text you type while the
button is highlighted will appecar in Bold. To revert to normal text, just
click the Bold button again, or press [Cirl]+[B] again.

The Nalic and Underline buttons operate in the same way, using [Ctrl)+(I]
and [CerlJ+{U].

Note that you can also change the Style of a section of text, by Selecting it
(see above), then clicking the style button you want. If you use the buttons
with no text selected, the button settings affect any text you type from then
on. If you use the buttons with some text sclected. the button scttings
nfTect the selected text.
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Text Size and "Point Sizes"
You can use the word-processor to type text in a range of sizes. The size of
printed text is normally measured in “Points” - one Point is approximately
'/72 inches. The range of type sizes available in the word-proccssor is as

follows:

. @ Pai

. £ Polmt

. 10 Point

° 11 Point

* 12 Poim

* 14 Point
|8 Point

e 24 Point

e 36 Point

e 72 Point

For morc information on choosing a Point size. see the Style Menu com-
mands later in this chapter.
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Menu Commands

The Document Menu
This menu contains commands for controlling aspects of the whole docu-
menl, including the commands for Editing, Saving and Printing them.

Discs, the Cabinet, and Folders

A word-processor document can be stored in the Cabinet. or on a floppy
disc. When you are creating a new document or sclecting a stored one for
cditing, use the Option Boxes labelled “Cabinet” and “Disc™ to choose the
document’s location. If you want to store your document on floppy disc,
you must insert a disc in the PcW16's disc drive before you choose the
Disc button.

Both the Cabinct and a PcW 16 floppy disc contain sixteen “Folders”, and
you can choose to store your document in any one of these. If you activate
the “Folder” drop-list (by clicking on it, or by pressing [Tab] until it is
highlighted then pressing [Space]), you will see a list of the folders avail-
able: if you have selected Disc, you will sec the names of the folders on the
disc, and if you have sclected Cabinet, you will see the names of the folders
in the Cabinet. Note that you can change the names of folders using the
File Manager program.

Start New Document
When you choose to Start a New Document, the word-processor automati-
cally saves the existing document. It then displays the following dialog:

You should first choosc the location for the new document you want to
create (soc Storing Yowr Work in chapter 2 for more information about how
your PcW16 stores documents and other files), then type a name for it. If
you just type the name without changing the location, the document will be
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stored in the Default Storage Location - this is normally Folder number
One in the Cabinet, but you can change it using the File Manager program.
Document names can normally be up 1o 32 letters long. If you try to type a
letter but it does not appear, this means that the Ictter you have typed is not
allowed in a document name. Characters which cannot be used in docu-
ment names include the question-mark (7). the asterisk (), the slash char-
acters (\ and /), the bar (]), and the full-stop (.).

Once you have entered these details for your new Document, press . You
will then see a dialog which allows you to choose the Template on which
the new document will be based. Once you have selected a Template and
pressed /., you can stan typing the text for your new document.

The PcW16 is supplied with a number of Templates built-in, but you can
alter these Templates to suit your own needs, or design your own new
Templates from scratch. For more information about creating Templatcs,
sce the Make New Templute command,

Edit Stored Document
This command allows you recall a stored document, so that you can make
changes to it or reprint it. When you choose the Edit command, the pro-
gram displays a dialog allowing you to choose a stored document to edit:
for a guide to using the Disc / Cobinet selector and the Folders list, sec
Step 6: Editing a Stored Document in chapter 2.
When you choose a document and press /, the document is loaded into the
word-processor, and you can then edit it as normal.

Save As
This command allows you 10 save the current document under a different
name, and/or in & different location. It displays a dinlog which allows you
to type a document name and choose a location, just as in the Start New
Document command above. When you press /. the current document is
saved in the new name and location.
Note also that the old document is left intact, stored under its old name.
This means that you can reload and edit the old version of the document
cven afier you have made changes to the new onc.
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Revert to Saved
This command abandons the current version of your document, and
reloads the last version which you saved. 1t allows you to undo any
changes you have made since the last time you saved your document. It’s
a good idea to save your document regularly, using the “Save and Con-
tinue™ command in the Tasks menu.

Iimport Document
This command allows you to cenvert a document created using a different
word-processor or computer, and make It into a PcW 16 document so that
you can usc it
The Import command displays a dialog like this:

11/8)/98
88/ 01/

1780 %
1B/

In order 1o Import a document, it must be stored on a disc formatted as
DOS. CP/M or Locoscript. The illustration above shows how a typical
DOS disc with files stored in its Root directory might appear,

Importing Documents from PC-Compatibles

Ifthe disc is DOS format, the file containing the document must be stored
in the disc’s “Root”™ directory. The Import dialog displays a list of all the
files in the Root directory - if the file-name you want does not appear in
the list, it is not stored in the disc’s Root directory, and cannot be Imporied
unless you transfer it to the root dircctory using another computer.
Documents from PC-based word- processors must be stored as plain
ASCII text. or in “Rich Text Format™ (sometimes called “RTF™), if you
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want to import them into your PcW16"s word-processor. You will nor-
mally get the best results by Exporting the document from your PC word-
processor as an RTF file, rather than as ASCII - RTF files include style
and formatting information, while ASCII files contain only the plain
document text. You can normally create ASCIl or RTF versions of docu-
ments using “Save As” or “Expont” commands within your PC-based
word-processor.

Note that RTF comes in different “flavours™, and there arc small difter-
ences between the RTF flavours used on different computers and operating
systems. The PcW 16 supports the Microsoft Windows flavour of RTF, so
importing RTF files from other sources may produce small errors in the
conversion of particular characters.

importing Documents from Locoscript and CP/M

If you created the file using an carlicr PcW 16 computer (the PCWB256,
8512,9256, 9512 or PCW10), the disc containing the document will be a
CP/M or Locoscript format disc. Your PcW | 6 word-processor can impon
documents from any PCW version of Locoscript, and from other PCW
word-processors such as Protext, providing that the documents are stored
on 3%" disc. (If you nced to transfer documents from 3" PCW discs,
please contact Amstrad Direct at the address at the beginning of this
manual, for information about the "Locolink® file transfer system.)

When Importing from a CP/M or Locoscript disc, you should be aware that
documents can be stored in any of the 16 “Groups”™. When you choose the
Import command and insert a CP/M or Locoscript disc, the Import dialog
shows a list of all the documents in Group 0 on the disc - if the document
you want to Import is in a different Group, you can change Groups using
the “Groups™ drop-list. Note that Locoscript documents are stored in
Group numbers 0 to 7, which can have names instead of numbers. (Any
documents in Groups 8-15 on a Locoscript disc are “Limbo” files.)

Once you have sclected the correct Group, choose the name of the file you
want to Import from the list of file-names.

Export Document
Exporting a document means saving it on a disc in a format which can be
understood by another computer or word-processing program. The PeW 16
word-processor can export in two different file formats, called “ASCII™
and “Rich Text™ (or “RTF") formats.
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ASCII Files

ASCII is an American Standard code, and is understood by virtually all
word-processors, and many other computcer programs. It is the most
widcly-used way of transferring text between different computers and
systems. However. the ASCII standard does not include many of the
characters you can type on the PCW: although the A-Z alphabet, numbers
and basic punctuation characters (commas, full-stops etc) will be trans-
ferred correctly using ASCII, some accented characters and less commonly
used letters (such as musical symbols, arrows etc) are not standard ASCII
characters, and may be omitted from the cxported document. More impor-
tantly, ASCII is a “plain text”™ format - it contains all the leticrs and words
in the document, but does not include any information about how these
letters are supposed 1o look. When Imported, an ASCI document will use
only one font, and will contain no Bold, ltalic or Underlined text, and no
Tabs or Indents. This kind of information can only be imported using the
Rich Text Format. K

Rich Text Format Files

Rich Text Format (RTF) is a more versatile format, and will include all
characters from the document, and some formatting information including
Headers and Footers. Ahhough it is not possible to make your PcW16
document look exactly like the original document from the PC word-
processor, RTF format provides the best way of converting documents
between different types of computer.

Set Paper Size
This command allows you to define the paper size for your document:

Y ou can choose to use A4 paper (297x210mm), or the American Letter or
Legal paper sizes by clicking the appropnate boxes. You can also specify
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yoOur own custom paper size, by clicking the "Custom” box, then entering
the dimensijons you want in the Height and Width boxcs, or usc the B
spinner buttons. When using Custom sizes, note that the paper cannot
exceed 216mm in width, or 356mm in height.

Units

The paper size can be entered in any units. Providing that you add the
Ictters “mm”, “cm™ or “in™ after the number, the size will be automatically
converted into the units sct by the Sef Preferences command.

Plcasc notc that your printer may have other limitations which may prevent
it from using particular paper sizes: please consult your printer manual for
more information.

Set Margins
This command allows you to sct the Margins between the edge of the paper
and the edges of the printed text:

It also includes an option for using Single or Facing pages. With Single
pagces sclected, cach page uscs the same margins at the left and right.

O
La® gt ede
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Single Page Faang Pages

Amurad PCWI6 Page 69



Reference: Word-Processor

Facing pages are designed to be viewed in pairs, like the pages in a book or
a ncwspaper. Pages with even page-numbers are left-hand pages, and
pages with odd page-numbers are right-hand pages. Instcad of having Left
and Right margins, Facing pages have Inside and Outside margins. as
shown above.

When using Facing pages, you can use different Headers and Footers for
left and right pages. In the illustration on the previous page, you can sec
that the header on the left-hand page is left-aligned, while the header on the
right-hand page is right-aligned. This means for example that you can
place page-numbers or other information in a header or footer so that they
always appear af the outer edge of the page, as shown.

Headers / Footers
This command allows you to enter text for your document's Headers and
Footers. [t also lets yvou control the Header and Footer printing options.
When you choosc the command, the program displays the following dialog:

Setting the Header and Footer Printing Options

There are four independent printing options for Headers and Footers.

The first two options are “Print Headers™ and “Print Footers™. These
control whether the Headers and Footers are printed at all - switching these
options off means that Header and Fooler text will never be printed.

The second two options control whether to print the Header or Footer text
on the first page of your document. Because the first page of a document is
often a title page, which is laid out difTerenily to the other pages, it is often
uscful to omit the Header and/or the Foolter from the first page, while still
printing them on subsequent pages.
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kditing Header and Footer Text

The “Editing” pancl comains buttons which let you Edit either the text used
in the Header or the Footer. If your document uses Facing Pages (scc Ser
Margins above), the panel also contains Option Boxes 10 select whether to
cdit the Header/Footer text for Left pages, or for Right pages.

When you choose one of these buttons, the screen changes 1o allow you to
cdit the Header or Footer you have chosen. The top of the screen looks
something like this:

Tim @ @ nenbe Tt Mo Go §gpebard gage - O 8 Puge Bowes (Fogny

This screen operates in a similar way to the normal document editing
screen. You can type the text for the Header or Footer you chose in the
previous dialog. and you can set the text size and style, and the Tab ruler
scttings, using the commands in the Style menu. You can also insert the
current Time and Date, and other characters and numbers, using the
commands in the Insert menu.

Notc that while Headers and Footers can contain any amount of text, they
can only be a single paragraph - you cannot have morce than onc paragraph
in 8 Header or Footer. This means that the [Returm] key does not work as
normal when editing Headers or Footers.

Automatic Page Numbering
As well as plain text, Headers and Footers can also contain a special code
for printing the current page number, so that you can automatically include
a page number in the Header or Footer on each page. You can inscrt this
code anywhere in the Header/Footer text by clicking the PAGE NUMBER
button, or by typing «

{Page}
- at the point in the text where you want the page number to appear.
This code appears on the editing screen as "{Page)”, as shown in the
illustration above. When you print the document, it is replaced automati-
cally by the correct number on cach printed page.
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For examplec, if you are editing a Footcr, and you type the word “PAGE",
then a space. then click the PAGE NUMBER button, the screen will show
the text in the footer like this...

PAGE {Page)
...but on the final printout, the word-processor will print...

PAGE 1 (at the bottom of page 1)

PAGE 2 (at the bottom of page 2)
-..and so on.
When you have finished editing your Header or Footer text, ¢l icking the
Finished button will return you to the original Headers and Footers dialog.
You can then choose to edit a different Header or Footer (remember that
documents which use Facing Pages contain two Headers and two Footers),
sct the printing options, or click OK to retumn to your document.

Make New Template from Document
This command allows you to create your own Template, using the scttings
from the current document. When you choose the command, the program
asks you to type 2 name for the new Template. Once the Template has
been created. it will appear in the Templates list whenever you Start a new
document.
A Template includes all the options sct by the Paper Size and Margins
dialogs, the document Header(s) and Footer(s), and the list of Paragraph
Styles, Whenever you use the new Template, the settings of all these will
be recalled

Including the Document Text

Wiy documeng costmmsn somd Wal - @9 you ward
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As well as layout and style information, Templates can also include text. If
you choose the Make New Template command when the current document
alrcady has some text included in it, you will be ofTered the option to
include this text in the Template as shown above. If you choose to include
the text, any new documents based on the Template will have this text
awomatically inscrted at the beginning, though you can casily delete it from
the new document once you start editing.

l
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word Count
This command counts the words in your document, or in the currently
sclected text. If you use Word Count with no text selected, the command
simply reports the number of words in your document. I you use Word
Count while text is selected, you can choose whether to count the words in
the whole document, or just those in the selected section.

Check Spelling
When you choose this command, the following dialog is displayed:

You can choose whether 1o check just the word in which the cursor is
currcntly positioned, or check the spelling in the whole document. You can
also choose to check from the current cursor position until the end of the
document.

Each word is checked in two different dictionaries: the standard dictionary
and the User dictionary. The standard dictionary contains approximately
48,000 common words, but you can also build up your own custom dic-
tionary - sec Adding a Word to the User Dictionary below..

Correcting a Misspelt Word

When the program comes across an unknown word during a spell-checking
run, it displays the following dialog:
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The dialog shows the unknown word, and includcs a list of the words from
the standard dictionary which match it most closely. If the unknown word
is spelt wrongly, you can type the correct spelling in the Replace With box,
or click on the correctly-spelled word in the list, then click the Replace
button (or press [F2]). The misspelled word is then replaced with the
correct one. If you selected the Whole Document or From Cursor option,
the program continues looking through the text until it finds another un-
known word, or until it reaches the end of the document.

Adding a Word to the User Dictionary

If the unknown word is correctly spelled, it must be missing from the
dictionary: this may be because it is a special word (such as a name), or
some technical term (like “PCW™), which would not be included ina
standard dictionary. To prevent the spell-checker from stopping and asking
you to correct the spelling every time it finds such a word, you can add
words to the “User Dictionary”™, which is also used by the spell-checker if it
is unable to find a word in the standard dictionary.

To add an unknown word to the User Dictionary, simply click the Add
button (or press [F3)) when the spell-checking command reports the word
as unknown. Once you have Added the word to the User Dictionary, it will
always be recognised by the spell-checker, and will not be reported as an
crror.

Skip

Click this bution (or press [F1]) to tell the spell-checker to ignore the
unknown word, and continue checking the document.

Re-Paginate Document
As you edit your document, the word-processor program normally alters
the display to reflect the changes you have made. However, when you
insert text into an existing paragraph, the program must create a new,
empty line for your to type on, even when there will be no empty linc in the
finished document.
Re-Pagination is the process whereby the program reorganises the screen
display to correspond exactly with how the text will be printed - the docu-
ment is always re-paginated automatically before it is Printed or Saved, but
if you want to force the program 1o re-paginate while you are editing the
document, you can use this command 1o do so.
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print Preview
This command displays a picture of how a page (or a pair of facing pagces)
from the current document will appear when Printed. Print Preview isa
useful way of checking that the printout is correct without actually print-
ing, because it includes the page Headers and Footers.

The Print Preview screen has buttons for moving forwards or backwards
through the document, and a Print button which acts as a short-cut to the
Print command,

Print Document
This command prints the current document. When sclecied, it displays the
following dialog:

If you press ¢ without changing any of the Print dialog options, the pro-
gram prints a single copy of the whole document. You can use the options
in the dialog to print multiple copies, and/or to print only the current page
(ie where the cursor is located when the Print command is selected).

The third option appears as a pair of boxes for setting Draft or Quality
printing. Depending on the printer type, you may be able to choose a
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“Draft” print which uses less ink or toper than a Quality print, and may be
faster. However, not all printers have this feature, and changing this option
may not make any difTerence to your printout. 1‘

Mail-Merge Printing
Mail-Merge printing is a method by which a standard letter can automati-
cally be sct up to include personal details of different people or companics.
It uses the information stored in the Address Book entrics to merge details
such as names and addresses into a letter or other document, then prints a
scparate, personalised copy ol the document for each recipient.
There is a Mail-Merge code for cach “ficld” in an Address Book entry: the
process of Inserting Mail-Merge Codes in your document is explained
below. If your document includes any Mail-Merge codes, the Print com-
mand has an extra dialog which allows you to choose which of the entries
in the Address Book are used to create printed documents.
Choosing Entries from the Address Book
When you choose the Print command with a document which includes onc
or more Mail-Merge codes, the normal Print dialog is displayed as de-
scribed above, then a second dialog appears showing a list of the entries in
the Address Book:
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You can choosc which entries to include in vour Mail-Merge print by
clicking on them in the list, or highlighting them using T4 and [Space].
You can also choosc to include all of the entries using the SELECT ALL
button, or you can cancel all the selections you have made using the
DE-SELECT ALL button.

When you have made your selections for Mail-Merging, press / to begin
printing. The word-processor will now print a separate copy of the docu-
ment for each entry you have selecied, and will replace cach Mail-Merge
code in the document with the contents of the relevant ficld in cach Address
Book entry.

Abandon Document
This command allows you to exit from the word-processor program
without saving the current document. This operates as an alternative to
pressing [ Stop] - it allows you to retum to the Desktop without over-
writing an earlier version of the current document.
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The Edit Menu

Many Editing commands can operate only on the currently Sclected scction
of text, and may be unavailable if no text is sclected. Commands which are
unavailable arc "greyed-out”.

Cut Selection to Scratchpad
This command is only available if a scction of text has been sclected. The
command deletes the sclected text from the document, but stores it on the
Scratchpad. The text can then be Pasied back into the document in a
different position: see Paste below,
Once text has been Cut onto the Seratchpad, it remains there until a difTer-
ent section is Cut or Copied, at which point the existing Scratchpad con-
tents are discarded,

Copy Selection to Scratchpad
This command is only available if a scction of text has been sclected. The
command copics the sclected text onto the Scraichpad, but unlike the Cut
command above, it leaves the selected text itself intact in the document.
The text can then be Pasted into the document in & difTferent position: see
Paste below.
Once text has been Copied onto the Scratchpad, it remains there until a
different section is Cut or Copiced, at which point the existing Scratchpad
contents arce discarded,

Paste from Scratchpad
This command is only available if there is text on the Scratchpad - you can
place text on the Scratchpad using the Cut and Copy commands as de-
scribed above.
When you choose Paste, a copy of the Scratchpad 1ext is inserted into the
document at the current cursor position, just as if it had been typed at the
keyboard. After Pasting. the text remains on the Scratchpad, and you can
Pastc it into the document as many limes as you like.

Delete Selection
This command simply deletes the selected text from the document.
If you accidentally Delete a section of text which you want to keep, you
can usually recover it by pressing [Undo] immediatcly. Note that once you
have used any other menu commands or edited the document gffer an
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accidental Delete, the Undo command will be unable to recover the deleted
text.

Store Selection as Phrase
Your PcW16 can store up 10 cight “Phrases”™, and this command is used to
Store the currently selected text in one of these cight Phrase numbers.
Once stored, a Phrase will remain available until you Store a different
scction of text in the same slot. A Phrase can contain up to 250 characters.
The Store Phrase command displays the following dialog:

This dialog lists the cight Phrasc numbers (F1-F8), and shows their current
contents. To store the currently selected text as a Phrase, you must choose
a Phrasc number from the list using the T4 keys or by pressing [F1]-[F8] .
then press . When you store a new Phrase, the previous contents of that
Phrase number are discarded.

Note that the Stored Phrases are part of the word-processor as a whole, not
part of an panticular document. When you make a change to the list of
Phrascs, the new list will apply to all future documenis.

Hot-Keys for Storing Phrases
While editing a document, you can Store the current sciection as a Phrase
by pressing [ Task]+[Cul)+[F1-8], instead ol using the menu command.
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Find Text
This command scarches through your document for a particular word,
phrase, or sequence of lctters or numbers. When you select the command,

it displays the following dialog:

When you have typed in the text you want to Find and pressed /, the
program will begin scarching through the document, starting from the

curtent cursor position.
When it finds an occurrence of the text you entered, it highlights the text,
and the screen changes to look like this:
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In this "Text Found™ state, the Find command is still operating. so you
cannot choose a different command or nccess the menus until you have
cancelled Find.

At the top left of the screen, the program displays the text you have entered
in the box labelled “Finding:™. You can click on this box (or press [Tab)
repeatedly until it is highlighted) then alier the text. 1fyou alter the Find
text, pressing one of the Find buttons will make the program scarch for the
new text you have entered.

If you press STOP, the Find command is cancelled and the screen retums to
its normal editing modc, but the cursor remains at the text which was
Found.

If you press FIND NEXT, the program continues scarching until it finds
another occurrence of the text, then stops and highlights that occurrence.
By repeatedly pressing the FIND NEXT button, vou can find every occur-
rence of the text in your document.

If you press FIND FIRST, the program searches for the lext siarting al the
beginning of the document. instead of from the current cursor position.
Pressing HELP displays a Help screen as normal - Help is provided as a
button because the Menu Bar cannot operate while the Find command is in
progress.

The *Match Case® Option

When you first choosc Find and type in your texi, you ¢can choose the
Match Case option. Upper and Lower Case mean capital and small lctiers
respectively: when Match Case is sclecled, the command will only Find
those incidences of the text where the case matches exactly what you typed
in the Find dialog. If you Icave the Match Case box blank, the command
will find all incidences of the text, regardless of whether the letters arc in
the same casc as those you typed
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Replace Text
This command searches through your document for a word or phrasc which

vou enter, then offers you the option to replace it with a different word or
phrasc. When you select the Replace command, it display's the following

dialog:

First type the text you want to find, then press [Tab] to move to the Re-
place box, and type the text with which you may want to replace it. You
can also choose the *Match Case”™ option: sce Find above.

When you press , the program will search forwards from the current
cursor position. When it finds an incidence of the text 1o be replaced, it
displays the following screen:
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In this “Text Found™ state, the Replace command is still operating. so you
cannot choose a different command or access the menus until you have
cancelled Replace.

The top left comer of the screen displays the two Find and Replace 1exts.
You can sclect and edit these by clicking on them, or by pressing [Tab)
repeatedly until the text vou want to edit is highlighted. The Found text is
highlighted on the main screen.

If you press STOP, the Find command is cancelled and the screen retums to
its normal editing mode, but the cursor remains at the text which was
Found. Note that any text Replacements you have made since the Replace
command was s¢lected are kept, and cannot be undone.

If you press REPLACE, the Found text is replaced by the Replace text, and
program automatically continues scarching until it finds the next occur-
rence of the Find text.

If you press REPLACE ALL, the program immediately scarches through
the remainder of the document, and automatically replaces all occurrences
of the Find text with the Replace text, without stopping to confirm cach
onc.

If you press FIND FIRST, the program starts searching from the beginning
of the document, instecad of from the current cursor position.

If you press SKIP, the highlighted text is lefl intact, and is not replaced.
The program continues scarching through the document for the next occur-
rence of the text.

Pressing HELP displays a Help screen as normal - Help is provided as a
button because the Menu system is disabled while the Replace command is

operating.

Select Whole Document
This command provides a quick way to Sclect the whole document, by
automatically placing the Start Marker at the beginning of the document,
and the End Marker at the end.
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The View Menu
The View menu commands affect the way in which the document is dis-
played on the screen, but they do not make any changes to the document
contents. Changing View commands may make the document appear
different on the screen, but they have no effect on the document itself.

Tabs and Returns
This command displays Tab and Return characters on the text screen as
svmbols, so that you can sce where they occur in the text. Retum charac-
ters arce added whenever you press the [Retum] key to start a new para-
graph. The symbols look like this:

\lr Retum
- Tab
Spaces

This command displays a small circle in all the Spaces between words.
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The Insert Menu

Overwrite Mode
This command switches between Insert and Overwrite modes.
When the word- processor is operating in Insert Mode (the default), as vou
type new characters at the cursor, they are Inserted into the document, and
any text which appears after the cursor moves down the documcnt to make
room for them.
In Overwrite Mode, the new characters replace the old characters, so that
as you type cach character, the character ahead of it is deleted.

insert Another Document
This command operates exactly like the “Edit Document™ command. [t lets
you choose a document from any Folder in the Cabinet or on disc. When
you press /, the document is inserted at the current cursor position, just as
if you had re-typed it. Note that the Paragraph Styles and formatting
information from the inserted document will not be preserved - instead, the
document text will be formatted according to the current Paragraph Style in
the new document.

Insert Stored Phrase
This command displays a list of the phrases you have previously Stored
(see the Store Selcction as Phrase command in the Edit menu), so that you
can choose one to Insert:

You can select a phrase in the list using the T4 keys, or by pressing [F1}-
[F8). When you press /, the phrasc you selected is inserted in the docu-
ment at the current cursor position.
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Hot-Keys for Inserting Stored Phrases
While editing a document, you can also Insert a Stored Phrasc dircctly by
pressing [Cirl)+{F 1-8], without using the menu command.

insert Today’s Date
This command insecrts the date at the current cursor position. The date is
taken from the PCW's own intemal clock. It is entered as ordinary text,
which you can edit if you wish.
The format of the date can be changed using the Preferences command in
the Options menu - you can choose from a number of diflerent formats,

including numeric (cg 31/01/96), or a more fully worded format (e 3 15t
January 1996).

Insert Current Time
This command inserts the time at the current cursor position. The time is
taken from the PCW's own internal clock, at the moment at which you
sclect the command.
The format of the time can be changed using the Preferences command in
the Options menu - you can choose from a number of diffcrent formats,
including options for 1 2-hour (eg 06:30pm) and 24-hour (eg 18:30).

Insert Name/Address
This command allows you 10 insert an entry from the Address Book into
your document. It displays a list of all the Address Book entrics, and
allows you to choosc one.
You can sclect an entry from the list by clicking with the mousc, or by
using the T{ keys, then press / to insert the entry into the document. All
the ficlds from the entry will be inserted, except the Notes ficld - after
inscrting the entry, you may want to delete any information you do not
want to be included in the document.
You could use this feature in preference to Mail-Mcerge if you want to send
a letter 1o a single recipient.

Insert Calculation
This command pops up the Calculator, and allows you to use it in the
normal way to calculate a number. When the calculation is complete, and
you click the Exit button (or press ) to exit from the Calculator, the result
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of the calculation (/e the number which was on the calculator display when
you chose Exit) will be inserted into the document.

Insert Character

This command allows you to choose a character to insert into the docu-
ment. It displays the following dialog:
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Most characters (such as the standard A-Z alphabet), are printed on the
keyboard keys, and even those which are not printed on key-1ops (such as
bullcts or diphthongs, or accented characters), can still be typed by refer-
ring to the table of characters in appendix E.

Nevertheless, it is still useful to be able to call up a display of all the
chamacters on-screen, and to sclect onc with the mousc or with the key-
board. This command displays a table of all the characters availnble,
allows you to sclect one, and to add an accent 10 it if you wish. When you
press OK, the character you have selected will be inserted into the docu-
ment.

To sclect a character or accent from the table using the MOUSE, simply
click on the one you want. With the KEYBOARD, use the [«-T1 ]
arrow keys to choose a character, and [Shift}+{« T4 -] to choosc an
accent.
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Note that two characters in this dialog arc invisible. The first entry in the
characier table is the Space, and inserting this has the same effect as typing
a Space. The first entry in the list of accents (the one highlighted in the
illustration above) is blank, and gives an unaccented character when
sclected.

Insert Mail-Merge Code
This command sllows you lo inscrt a “Mail-Merge Code™ into your docu-
ment. Mail-Merging allows you to include information from Address Book
entries in your document, so that you can address the same letter to several
different people automatically. For more information about Mail-Merge
Printing, sec the Print command above.
When you choose 1o Insert a Mail-Merge Code, the program displays a list
of the “ficlds” in thc Address Book. Choose a ficld from the list by clicking
on it or using the T4 keys, then press ¢ 1o insert the code.
Mail-Mcrge codes appear in the text of your documents in brackets - for
example, if you choose to Insert the "NAME " field, this will appear in the
text as

(NAME_1)

Once you have Inserted a code, you can delete it just by deleting the char-
acters as if the code were ordinary text. If you delete some of the code
characters but leave some behind (eg if you delete "{NA" and leave only
"ME_1}". this will no longer be recognised as a Mail-Merge code, and will
be printed as if it were ordinary text.
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The Style Menu

The Bold, Italic and Underline Commands
These commands change the style of the text in your document, and have
the same effect as clicking the Bold, ltalic and Underline buttons at the top
of the word-processor screen (see Style Oprions at the beginning of this
chapter). The commands and the buttons behave differently depending on
whether you have selected any text in the document when you choose the
command:

If a block of text is selected...

Choosing the Bold command will normally make all of the sclected text
bold. However, if the beginning of the sclected text was already bold,
choosing Bold will un-Bold the text. Choosing the Bold command repeat-
edly will make the sclected text switch back and forth (or “1oggle™) between
the bold and non-bold states.

If no text is selected...

Choosing the Bold command will make the typing style Bold. This mcans
that any text which you type from now on will be Bold. To stop typing in
Bold., simply choosc the Bold command again.

The Italic and Underline command operate in the same way as the Bold
command.

Use Larger/Smaller Font
These two commands change the text size, making the characters larger or
smaller. The PCW allows you to use up to ten different text sizes, from
6-point up to 72-point. (Type is always measured in “points™ - there are 72
points to an inch, so 36-point type is about half-an-inch tall.)
Like Bold, ltalic and Underline, these commands behave differently de-
pending on whether there ts any text marked. 1M text is marked, the com-
mands afTect the font size of the marked text. 1f no text i1s marked, the
commands affect the font size of the next characters you type.

Indent Paragraph
This command is a short-cut method of “indenting™ a paragraph from the
left margin. When you choose the Indent command, the Left Indent sctting
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of the paragraph containing the cursor is moved inwards, 1o the next tab
position.

Change Text Style
This command allows you to change all of the Style characteristics of your
text. Ifthere is any text sclected, the comimand affects the sclection, but if
no text is selected, the command scts the sty le options for the next charac-
ters you type.
The command displays the following dialog:

The different settings you can apply using this dialog arc as follows:

The FONT sctting can be changed to sclect any of the fonts you have
installed in your PcW16. By default, the PcW 16 has "Swiss”™ and “Times™
fonts, but fonts can be added or removed using the System Setup com-
mand. in the Deskiop's Sctup menu.

The POINT SIZE setting controls the size of the characters. For an
explanation of Point Sizes, sce page 63.

BOLD, ITALIC and UNDERLINE styles can be applicd by clicking the
approprintc boxes.

The NUMBERS IN COLUMNS sctting can be used to ensure that
vertical columns of numbers are properly aligned.

This is necessary because the PCW s typefaces are spaced proporitionally,
50 that narrow characters occupy less space than wider ones. I you want
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to create vertical columns of numbers, you need to select "Numbers in
Columns” o align the digits vertically.

mLn 111191

461135 461138

2222.22 2222.22

The NORMAL / SUPERSCRIPT / SUBSCRIPT boxes allow you to
choose one of these three positions for your text. The text will appear as
follows:

Thisisnormal lex). Tnwemotia o ercrptiest

Change Tab Positions
This command allows you to change the positions of the Tab Stops for the
current paragraph.
Even if you do not set any Tab Stops yourself, the word-processor auto-
matically adds its own default Tab Stops at equal intervals across the page.
If you add any of your own, all the default tab stops to the Icht of the one
you added are removed. The Tab Stop positions for the current paragraph
are indicated on the Ruler Line above the text:

Py Pt -
\/ blteut Tat e

|| User-Defined Tab Stops fUighd rckani brdeeshos

tat-Ling bndiend Indicatos
Loit indert bncficator
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When you choosc Change Tab Positions, the command displays the follow-
ing dialog:

You can add a Tab Stop at any position by setting the position you want
using the NEW TAB AT spinner (or by typing the position), then clicking
the ADD NEW TAB button (or pressing [A]).

You can delete a Tab Stop by choosing it from the list, then clicking the
DELETE SELECTED TAB button (or pressing [D]). Note that the list
only displays tab-stops which have been entered by hand - you cannot
delete the default tab stops.

Change Paragraph Format
This command allows you to change the format settings for the current

paragraph.

The settings in this dialog are as follows:
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SPACE ABOVE controls thc amount of vertical space which is left cmpty
before the paragraph text begins.

SPACE BELOW controls the amount of vertical space which is left empty
at the bottom of the paragraph, before the next paragraph begins.

NOTE: the vertical space which will be left emply between onc paragraph
will be the Space Below the first paragraph PLUS the Space Above the
sccond paragraph.

The LEFT and RIGHT INDENTS arc the spaces left empty at the sides
of the paragraph. Thesc are measured from the document Margins. which
are sct using the St Murgins command in the Document menu.

The IST LINE INDENT is the same as the Lefl Indenl, but applics only
to the (irst line of the paragraph. This allows the left edge of the first line
to be different from the rest of the lines in the paragraph, so that you can
indent the first line, or create a “hanging indent™.

Each paragraph can be ALIGNED to the LEFT, RIGHT or CENTRE,
or can be JUSTIFIED 1o give straight margins on the left and right edges.

Finally. the LINE SPACING for the paragraph can he set to SINGLE,
1%, our DOUBLE.

Use a Paragraph Style
This command allows you to apply a Parmgraph Style to the current para-
graph. or to a Sclected block which may contain scveral paragraphs. The
command displays this dialog:

Click on the drop-list to display a list of the Paragraph Styles in your
document, then choase a style using T4, and press . The chosen Para-
graph Stylc will be applicd to the paragraph which currently contains the
Cursor.
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Edit a Paragraph Style |
This command allows you to alter the settings of a Paragraph Style - see

the beginning of this chapter for an introduction to Paragraph Styles. Each
Paragraph Style includes settings for the Text Style, the Paragraph Format,

and the Tab Positions, so that it forms a complete description of a para-

praph’s appearance.
When chosen, the command displays the following dialog:

First, you must choose which Paragraph Style you want to change, by
choosing a style name from the drop-list at the top of the dialog.

Once you have chosen a Style to edit, click one of the buttons to choose
which seuting you want to change. The buttons for TEXT STYLE, TAB
POSITIONS and PARAGRAPH FORMAT display the samc dialogs as
the commands of the same names - see the descriptions of these commands
carlier in this chapter for more information about cach dialog.

The dialog also contains a fourth button labelled STYLE NAME, which
allows you to change the name of the Paragraph Style you are editing.
Finally, there is a drop-list for the FOLLOWING STYLE. This allows
you to choose which Paragraph Style should be applied automatically to
the next paragraph, once the Retumn key has been pressed. For example, if
you have a Paragraph Style for Headings, you might want to set the Fol-
lowing Style to be a Body Text style, so that Body Text is automatically
applicd to the paragraph below the beading.

Onec option in the Following Style list is for SAME STYLE. - this means
that the following paragraph will be in the same style as the previous one,
and is a suitable option for paragraph styles sct up for the main body of
document text. If Same Style is sclected, when you press [Return] to stant
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a new paragraph, all the paragraph format and text style options which
were operating at the position where you pressed [Retumn] will be used in

the new paragraph.

store Paragraph As Style
This command allows you to create a new Paragraph Style using the style

and format scttings of the paragraph which currently contains the cursor.
I'he command displays the following dialog:

Because there are only 21 styles available, when you create a new Style,
you must replace an existing onc. As well as providing a box for the name
of the new Style, the dialog also contains a drop-list of the 21 styles, so
that you can choose which one to replace. |
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The Options Menu

Set Preferences
This command allows you to sct some of the gencrml uscr-options for the
word-processor. Note that the options you set in this dialog will apply to
the word-processor program in general, every time you use it. They are
part of the document, but pant of the program itsclf,
The command displays the following dialog:

[ 38 b s
The INCHES / MILLIMETRES boxcs sclect the units used for measu

ment throughout the word-processor program, including the dialogs for
scuting the Paper Size, the Margins, and the Tab Ruler.

The DATE FORMAT and TIME FORMAT arc used to sct the formats
uscd by the Inscrt Date and Insert Time commands. Each setting has a
drop-list of the different format options.
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The Spreadsheet
what is a Spreadsheet?

A spreadshect is a kind of calculator - it lets you enter numbers into its
“cells”, perform calculations on these numbers, then display the results of’
these calculations in other “cells™. You can also use the cells to display
text instead of numbers - this is handy for adding labels or other informa.
tion to your spreadsheet,

The ventical “Columns” of cells are labelled using the letters A to Z, and
the honizontal “Rows™ are numbered | 10 250. This means that you can
refer to cach cell by a “cell reference™ which is a combination of its column

and row,
A B C D B ‘4
b § Al B1 Cl D1 El Fl
2 A2 B2 C2 D2 E2 F2
3 Al Bl Cc3 D3 E3 F3

...and so on. In the illustration below, for example, cell Al contains the
words “Fund-Raising”, and cell CS contains the number 150.
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The Current Cell

One cell is always highlighted as the “Current Cell”, and {ts contents are
displayed in the “Contents™ box at the top of the screen, as well as on the
spreadshect screen itsclf. In the illustration, cell B3 is the Current Cell,
and it contains the word “"Event™.

Text and Numeric Cells - Formatting
The spreadsheet cells can display two different types of information. Text
Cells contain letters, or a mixture of letters and digits. Text cells cannot be
used in calculations, but arc a useful way of adding labels and titles to the
spreadsheet. Numeric Cells contain numbers, or sometimes “Formulae”
which work out numbers by doing calculations on the numbers in other
cells.
The format and style in which a ccll's contents appear on the spreadshect
arc controlicd by the "Formatting” options. There is a fixed number of
formats, and the formats available for Text and Numeric cells are com-
pletely separate - you can only apply a Text format to a celt which contains
Text, and you can only apply a Numeric format to a cell which contains a
number or a formula.
Numeric Cell Formats allow you to control the number of digits shown to
the left or right of the decimal point, and also allow you to include a
“Currency Symbol” to indicate that the number refers to an amount of
money. (The default currency symbol is the "£° pound sign, but you can
change it.) You can also define your own numcric formats, (eg changing
the way in which the numbers are aligned, or how negative numbers are
indicated) using the Define Numeric Formats command.
Text Cell Formats are pre-defined, and you cannot change them. Youcan
simply choose any combination of Bold or Normal text, and Lefi, Centre or
Right alignment.

Entering Information in a Spreadshect Cell
Using the Keyboard
You can type text or numeric information into a particular spreadsheet cell
by moving the cursor over that cell using the cursor keys (T4 ), then
typing the information you want (o enter.
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Using the Mouse and Keyboard

You can type text or numeric information into a particular spreadsheet cell
by clicking on that cell, then typing the information you want 1o cnter on
the keyboard.

With the heyboard, use the « T4 keys 1o move the current cell cursor,
then press (Ctrl]+{D] to enter or edit the cell contents.

Entering Text and Numbers

If you simply type a number, the spreadsheet will assume that this is
numeric data, and will display and formst it according to the “Default
Numeric Format™ setting in the Options menu. Likewisc, if you enter a
picce of text, the spreadsheet will assume that this should be formatted
according to the “Default Text Format™. In cither case, you can apply a
different display format for the information by clicking on the “Formar™
drop-list near the top right of the screen.

Using a Formula to Calculate Values
As well as simply displaying columns and rows of numbers and text, a
spreadshect can also calculate new numbers using Formulac. A formula
uscs cell references (AL, C3 ctc, as shown above) to refer Lo other cells,
and to perform calculations using the numbers in these cells. For examplc,
the formula...

{(A1+B3)*A2

..would add together the numbers in cells Al and B3, multiply the result
by the number in cell A2, and displsy the result of this calculation. (See
the Formulae section later in this chapter for a list of the spreadsheet’s
formulac, and of thc mathematical functions and operators you can use in
them.)
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When a cell contains a formula, rather than text or a number, the Contents
box at the top of the screen shows the formula, while the cell in the spread-
sheet itself displays the result of the calculation.

Selecting and De-Selecting Cells
Some of the spreadshect commands can operate on a selected group of
cclls, rather than on a single cell. Groups of cells can only be sclected if
they are arranged in a rectangular block, as shown here:

Evemt labtege Costa Prafiy

’i".n._ [T
Quiz gt
Supper & Ciger
[ JPrresy o

Cade Saad

—— g

G o Pl ek

Tetal Preme| £9070.300
|
Notice that although a group of cells is sclected, the current cell (in this
case the one at the top left) is still highlighted separately. There is always a
current cell, even when a group of cells is selected - the only exception is
when a whole Row or Column is selected.

If a group of cells has been sclected, some commands (such as thosc used
to apply cell formats, or Cut/Copy the cell contents to the Scratchpad)
operate on all the cells in the group.

Selecting Cells with the Keyboard

To sclect a group of cells with the keyboard, hold down the [Shift] key
while moving the cursor over the required group. For example, to select
cells B2, B3 and B4, move the cursor to B2, then hold down the [Shift) key
and press [{] twice.

Selecting Cells with the Mouse

To sclect a group of cells with the mouse, place the mouse pointer at the
top left cell in the group, then press and hold down the mouse left button,
and move the mouse to the bottom right cell in the group.

De-Selecting Cells

To cancel the sclection with either the keyboard or the mouse, simply move
the cursor or click on a cell.

Page 100 Amstrad PCWI



Reference: Spreadsheet

e

Spreadsheet Menu Commands
The Spreadsheet Menu

This menu contains commands for controlling aspects of the wholc spread-
sheet, including the commands for Editing, Saving and Printing it.

Start New Spreadsheet
When you choose to Start a New Spreadsheet, the spreadsheet program
automatically saves the existing spreadsheet. It then displays the following

dialog:

You should first choose the location for the new spreadsheet you want to
create, then type a name for it. You can switch between the Cabinct and
Disc by clicking the relevant box, and you can choose a new Folder by
clicking on the Ell symbol to show the Folders list, then clicking on the
name of the Folder you want.

Sprecadsheet Names

Spreadshect names can normally be up 1o 32 fetters long. If press a key
but the character does not appear while typing the spreadsheet name, this
means that the letter you have typed is not allowed in a spreadshect name.
Characters which cannot be used in spreadsheet names include the ques-
tion-mark (?), the asterisk (*), the slash characters (\ and /), the bar (]), and
the full-stop (.).

Once you have entered these details for your new Spreadsheet, press /.
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Edit Stored Spreadsheet
This command allows you recall a stored spreadsheet, so that you can
make changes to it or reprint it. When you choose the Edit command, the
program displays a standard Filing dialog, in which you can choosc a
location and sclect a file to Edit.
When you choose a spreadsheet name from the list, then press /, the
spreadshect is loaded, and you can then alter or add to it as you wish.

Save As...
This command allows you 1o save the current spreadsheet under a different
name, and/or in a different location, thereby creating another copy of it.
The command displays the same dialog as that used in the Start New
Spreadshect command above, and you can type a name and choosc a
location in the same way. When you press /, the current spreadsheet is
saved in the new name and location.
Note also that the old spreadsheélt is left intact, stored under its old name.
This mcans that you can rcload and edit the old version of the spreadsheet
even after you have made changes to the new one.

Revert to Saved
This command abandons the current version of your spreadshect. and
reloads the last version which you saved. It allows you to undo any
changes you have madec since the last time you saved your spreadsheet. It's
a good idea to save your spreadsheet regularly, using the “Save and Con-
tinuc” command in the Tasks menu.

Import Spreadsheet
This command allows you to convent a spreadshect created using an carlicr
PCW model or other computer spreadsheet program, and make it into a
PcW 16 spreadshect so that you can use it. The spreadsheet data in the file
should idcally be stored in "CSV~ (Comma-Scparated Value) format, or in
"DIF~ format. However, the spreadsheet program will import any form of
text-based file, on the assumnption that commas and Tab characters arc
column scparators, and that Carriage Retumns are row separators.
In order to import a spreadshect, it must be stored on a disc formatted as
DOS, CP/M or Locoscript. The Import dialog’s "Disc Type” box shows
the format of the disc in the drive, and a list of the files on it.
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Importing Spreadsheets from PC-Compatibles

If the disc is DOS format, the file containing the spreadsheet data must be
stored in the disc’s “Root™ directory. The Import dialog displays a list of
all the files in the Root dircctory - if the filename you want does not appear
in the list, it is not stored in the disc’s Root directory, and cannot be Im-
ported.

Importing Spreadsheets from Locoscript and CP/M Discs

If you created the file using an carlier PCW computer (the PCW8256,
8512, 9256, 9512 or PCW10), the disc containing the spreadshect will be a
CP/M or Locoscript format disc. Your PcW 16 can impost spreadshects
from a 3'4" PCW disc, providing that the data is stored in a CSV or DIF
file.

When Importing from a CP/M or Locoscript disc, you should be aware that
spreadshects can be stored in any of the 16 “Groups™. When you choose
the Import command and inscrt a CP/M or Locoscript disc, the Import
dialog shows a list of all the spreadsheets in Group 0 on the disc - if the
spreadshect you want to Import is in a different Group, you can change
Groups using the “Groups™ drop-list.

Once you have selected the correct Group, choose the name of the file you
want to Import from the list of file-names.

Export
When you first sclect this command, you are asked to sclect whether to
export in ASCI/CSV or DIF format. You must choose one of these export
formats, and when you do, the program displays a dialog showing the
options available for the format you have chosen. You should tailor these
options to suit the program into which you intend to load the exported
spreadsheet data.
For more information about the meaning and cffect of specific export
options, Sclect HELP while the relevant dialog is displayed.

Recalculate Now
This command forces the spreadshect to recalculate the numbers displayed
in cells containing formulae. With a large sprcadshect, this process may
take a few seconds. See Auro-Recalculate for more information.
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The program will recalculate automatically when printing or saving. and
you can also choosc the "Auto-Recalculate” option in the Options menu to
make the spreadsheet recalculate every time any new data is entered. If tho
Auto-Recalculate option is selectied, you do not need to usc the Recalculate
command at all.

Set Print Options
This command controls which parts of the spreadsheet screen are included
in the printout when you use the Print command. There arc four differcnt
options, and you can select any combination of them.
The TITLE is the name of the spreadshect file. The GRID LINES are the
ventical and horizontal lines scparating the rows and columns, and the
COLUMN and ROW LABELS are the [ctters and numbers showing the

row and column references.

Print Preview ’
This command uscs the screen o show you a preview of how your printout
will look - checking the preview before you print the spreadsheet can save
yvou having to produce test prints. Sce the Print command below for more
information about spreadshect printing.

Print Sheet
When you Print a spreadshect, a single page is printed in Landscape (widc)
format- use the Print Preview command to sce how this will look before
printing.
The printing places the Current Cell at the top left of the printout, and
prints as many cells downwards and to the right of the current cell as it can
fit onto the sheet. If your spreadsheet is too big to fit on a single sheet, you
can print it onto scveral sheets by printing onc shect, then moving the
cursor 1o the first ccll which did not fit on the print, and choosing the Print
command again.

Abandon Spreadsheet
This command first asks you if you are sure that you want to Abandon the
current spreadsheet. If you confirm, the spreadsheet program terminates,
and any unsaved information in the active spreadsheet is lost.
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The Edit Menu

The Edit menu commands allow you to manipulate the contents of indi-
vidual cells, or Selected groups of cells.

Cut Selection to Scratchpad
This command empties the current cell (or all the currently Selected cells if
a group of cclls is Sclected). The command retains the cell contents on the
Scratchpad, so that you can retrieve them by Pasting: sec below.

Copy Selection to Scratchpad
‘This command copics the contents of the currently selected cells onto the
Scratchpad, but lcaves the cclls themselves unchanged. You can replicate
the Copicd cell contents in a different group of cells using the Paste com-
mand - see below.

Paste from Scratchpad

This command inserts the contents of the Scratchpad into the current cell -
you can place data on the Scratchpad using the Cut and Copy commands.-
I there is nothing stored on the Scratchpad, the Pastc command is greyed-
out.

If you have Cut or Copicd a Selected group of cells onto the Scratchpad,
Pasting not only inserts information into the current cell, but also into the
group of eells below and to the right of it. The number of cells afTecied
dcpends on the number of cells which were selected when the data was
Copicd onto the Scratchpad,

Edit Cell Contents
This command is used to edit the Contents of the current cell - it simply
moves the cursor into the Contents box above the spreadsheet, and lets you
change or delete the cell contents. While you are editing the Contents, the
[¢~] and [-»] keys move the text cursor left and right within the editing
box. while the [ T] and [4] keys move the cursor back into the spreadshect
arca of the screen, and terminate the Edit command.
When you have finished editing the cell contents, you can also press [Re-
tum) to retum to the spreadsheet. Note that you can also switch to Edit
mode by clicking with the mouse on the Contents box.
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Delete Cell Contents
This command simply delctes the contents of the current cell, or the cur-
rently Sclected group of cells.

Remove Row
This command removes the row containing the cursor. Itdeletes all the
cells in the row, and their conlents.
If you Remove a row by mistake, you can use the UNDO command to
retricve it, as long as you have not used any other commands since the row
was Removed.

Remove Column
This command removes the column containing the cursor. All the cells in
the column, and their contents, arc deleted.
If you Remove a column by mistake, you can use the UNDO command to
retricve it, as long as you have not used any other commands since the
column was Removed.

Sclect Row
This command is a quick way of selecting all the cells in the row which
currently contains the cursor. Once the row is sclected, you can use other
Edit menu commands to make changes to all the cells in the row.
You can also sclect a whole row with the mouse, by clicking on the title at
the left end of the row (eg clicking on the 001 * title will select the whole of
row 1).

Select Column
This command is a quick way of selecting all the cells in the column which
currently contains the cursor. Once the column is selected, you can usc
other Edit menu commands to make changes to all the cells in the column.
You can also select a whole column with the mouse, by clicking on the title
at the top of the column (eg clicking on the "A” title will select the wholc of
column A).

Select Whole Spreadsheet
This command is a quick way of sclecting all the cells in the spreadshect.
Once all the cclls are selected, you can usc other Edit menu commands to
make changes to them,
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You can also select the whole spreadsheet with the mouse, by clicking on
the top left corner ol the spreadshieet display.

Apply Format
This command lets you choosc a new format for the current cell or the
currently selected cells. It displays a list of the formnis appropriate for the
cell contents: a list of the text formats if the cell(s) contain text, and a list
of the numeric formats il the cells contain numbers or formulac.
Note that if you have sclected a group which includes both text and nu-
meric cells, you can only Apply a format to onc type or the other - you
cannot apply a Text format to numeric cells, or a Numeric format to cells
containing text.

Fill Across
This command only operates on a group of cells sclected across a single
row. |1 takes the contents of the left-most cell, and copies this data into the
other selected cells.

Fill Down
This command only operates on a group of cells sclected down 8 single
column. It takes the contents of the top cell in the group, and copics this
data down into the other sclected cells.

Change Column Width
This command allows you to change the width of the column which cur-
rently contains the cursor. Although all the spreadshect columns have the
same width by default, it can sometimes be useful to make particular
columns wider or narrower. The command displays this dialog:

In this illustration, the current cell contains the single word "Money®, so

this cell is shown in the dialog to indicate the current column width. You
can use the [«] and [—] keys, or click on the B and £ buttons, to make

the column narrower or wider.
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The Insert Menu

Inscrt Row
This command adds an cxtra row to the spreadsheet at the current cell
position. The existing rows below the current cell are all moved down to
make room for the new row, All the cells in the new row arc initially
cmply.

Insert Column
This command adds an extra column to the spreadsheet at the current cell
position. The existing columns to the right of the current celt arc all moved -
to the right to make room for the new column. All the cells in the new
column are initially empty.

Insert Date
This command simply inscris today’s date into the current cell, as text. The
format of the date can be sct using the Ser Date/Time Format command in
the Options menu.

Insert Time
This command sumply inserts the current time into the current cell, as text.
The format of the time can be sct using the Set Date/Time Format com-
mand in the Options menu.

li
1
!

insert Calculation
This command makes the Calculator pop up over the spreadsheet screen.
When you have made the calculation and you have the result you want
shown on the calculator display, press  to exit from the Calculator and
insert the number in the Spreadsheet. Note that calculstions arc always
Inserted as numeric data,
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The Find Menu

find Text
This command allows you 10 scarch through the whole spreadshect fora
particular sequence of characters or numbers. When you select the com-
mand, a dialog asks you to type the text you want to find. Type itand
press / to start scarching. The scarch begins at the top left of the sheet,
and works across the rows and then down the columns.
When the program finds your text in a particular cell, it will show the cell
at the top left of the screen, and move the cursor to make it the current cell.
If you want to carry on searching for the next occurrence, simply select
Find again, and press /. The new scarch will begin at the current cell, and
will find the next occurrence.

Go to Cell
This command allows you to move directly to a particular cell, by entering
the cell reference you want to move to. When you enter a cell reference (eg
"Al", or "G25%) and press /, the spreadsheet is scrolled so that the chosen
cell is displayed in the top left corner of the screen.
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Options

Display Grid-Lines
This command allows you to choose whether or not to display the vertical
and horizontal lincs which divide the spreadshect rows and columns.

Auto-Recalculate |
When you change or enter numeric data, this may affect the contents of
other cells, because the new cell value may be used in a formula by a
difTerent cell. This command is a togglc: when it is switched on, it cnsures
that all the cells are kept properly updated and recalculated every time you
change a numeric value. I
The drawback with auto-recalculation s that it can slow down the opera-
tion of the spreadsheet program - a spreadshect can contain many formulae,
and recalculating them can sometimes take a few seconds. If you find that
the spreadsheet takes too long to récalculate when you change numeric
values, you can switch ofT the Auto-Recalculate option. However, if you
do this, you must make surc that you force a full recalculation using the
Recalculate Now command in the Spreadsheet menu whenever you want to
be sure that the spreadshect is shawing the correct values in its numeric |
cells.

Note that even when the Auto-Recalculate option is switched ofT, the
spreadshect still recalculates automatically whenever you save or print the !
I

sheet
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Define Numeric Format

This command allows you to change the Numeric Format definitions. It
displays the following dialog:

The dialog has different sections which atfow you (o define different as-
pects of numeric display. At the top of the dialog is the name of the format
you arc redefining - it you want to redefine a different format, you can do
s0 by clicking on the K symbol to display the list of format namcs, then
choosing a different format from the list. 1f you want to give the format a
different name, you can type a new name into the box below the old format
name. The other settings are as follows:

Text Format can be Bold or Normal text, and the Text Alignment can be
left, centre or right-aligned within the cell arca. To format numbers in
vertical columns, as is normal for currency display, usce the right-align
option.

The Thousands Separator is the character used to separate groups of
three digits when displaying large numbers. The comma character is often
used as the thousand scparator, but you can also choosc to usc spaces, of
you can choosc to have no scparator.

The Number Display options allow you to select whether to use normal oe
scicntific notation - the Best Fit option uses normal notation for smaller
numbers, but switches 1o scientific notation if the number becomes too
large to fit into the cell.
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The Currency Symbeol box allows you to include a currency symbol at the
left of the numenic cell, and the Negative (nnnn) option shows negative
numbers in brackets, instead of with a ®-" minus sign. Negative numbers
are usually indicated in brackets in financial accounting documents.

Default Numeric Format
This option allows you to choose which of the Numeric formats acts as the
default. When you type numeric data into a new cell, the display for that
cell is formatied according to the current default, until you Apply a new
format to it
To choose a new default format, click on the B symbol, then choose a new
default format from the list, and press /.

Default Text Format
This command allows you to select which of the Text Formats is used as
the default when entering text into an empty cell. It works in the same way
as the Default Numeric Format command described above.

Set Currency Symbol
This command lets you choose a ncw character to indicate currency. The
Currency Symbol is set by default 1o the "£” character, but you can change
this to “$” for dollars, "¥" for Yen, and so on. Note that you can only use
one currency symbol at a time - if you want to display different curren-
cies in a single spreadsheet, you have to enter different currency symbols in
their own cells, as if they were ordinary text.
When selecied, the command displays a list of all the characters availabie,
and all the accents which you can add to them. To choose a new Currency
Symbol, usc the «-T1—» keys or click on the character you want. Ifyou
want to add an accent to the character, you can do so by clicking on the
accent you want, or by using [Shift}+[«] and [Shift]+[—].

Set Decimal Character
You can choose from three different deciinal point characters: the full-stop
and comma are standard punctuation characters, but the PcW16 also
provides a "Real” decimal point, which appears halfway up the height, like
this: “2-5". As with the currency symbol, you can only select one decimal
point character at a time.
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Set Date / Time Format
This command allows you to choose how the Date and Time are formatied
when you Insert them using the Insert Date and Insert Time commands.
Click on the Kl buttons to scc the lists of different formats available, then
choosc the format you want from cach list.
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Expressions, Functions and Operators

This section details the mathematical components which can be used to build
formulac in the Spreadshect program.

Mathematical Expressions which act on a Range

The following formulae can be used to build expressions. Each operafeson a
range of cells which are given in the form FN(start finish) where start and finish are
valid cell references separated by a colon. For example, AVERAGE(A3:07) and
PRODUCT(A1:A3) are valid formulae.

SUM(range) sum of all numecric values i the mnge
AVERAGE(range] or AVG{range) the average of all the values in the range.
PRODUCT(range) all the values in the range are multiplied together
SUMSQ(range) the sum of the squares of all the values in the range
COUNT(range) the number of the values in the range

Mathematical Expressions which act on a Single Argument
The following formulac can be used in expressions. All take a single argument,
X, which can be any valid expression itself.

SiN(x). COS{x). TAN(x} trigonometric functions with argument in degrees
StNR(x), COSR(x). TANR(x) wigonometric functions with argument in radians
DEG{x) the argument converted from radians 1o degrecs
RAD{x) the argument converted from degrees to radians
ASIN(x), ACOS{x), ATAN(x) the inverse trig function of the argument in degrecs
ASINR(x) ACOSR(x) ATANR(x)  the inverse trig function of the argument In radians
Stti(x), COSH(n), TANEKx) hyperbolic Irigonometric functions

ASINH{x), ACOSH(x), ATANH(x)  inverse hyperbolic trigonometric functions

RECP{x) the reciprocal of the argument

SQR(x) the square of the argument

SQORT(x) the square root of the argument

LOG(x) the base 10 logarithm of the argument

LN(x) the base ¢ (natural) logarithm of the argument
EXP(x) basc ¢ antilogarithm of the argument (ie ¢”x)
ABS{x) absolute valuc of argument

FLOOR(x) previous integer before argument

CEILING(x) next integer after argument

INT(x) ncarest intcger (0 argument

FACT(x) gives x! - factorial of the argument
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Mathematical Functions
The following functions can be used anywhere that a valid expression might
appear.

Pi returns the ratio of a circle’s diameter to its circumlerence (3.141592654)
»£  retuns the base of natural logarithms (2.718281828)

Mathematical Operators

Ihe following are the mathematical operators that can appear between two
cxpressions to build larger compound expressions. x and y represent valid
cxpressions.

(and) used to change order of precedence

ax used before a single value it is ignored

-X used before a single value to change its sign

Xey addition of two values

Xy subtraction of two valucs

Xy multiplication of two values

Xy division of two values

x*y the first value, x, 1o the power of the second value y
xMODy the integer remainder of division of the first value by the second
xDivy the integer division of the first value by the second
x%y gives y percent of x

x MAXy retums the maximum of the two values

xMiNy returns the minimum of the two values

xNCRy retumns the number of y combinations from x

xNPRy retumns the number of y permutations from x.
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The Address Book

The Address Book allows you to store a list of names, addresses and other
information in a kind of database. This section explains each Address
Book menu command in detail - see the Beginner's chapier for a simpic
guide to the Address Book screen and how to use il.

The Book Menu

This menu contains commands which affect the whole Address Book, and
the screen display.,

Alphabetic List of ...
You can use this command 1o choosc the order in which your Address Book
entries are listed on the screen. Because the Address Book has several
picces of information, or "Ficlds™, in each Entry, you can change the way in
which the list of Entrics is ordered.

By default, the list will be arranged in alphabetical order, based on the
contents of the "Namel " field in cach entry. You can also choose to basc
the alphabetical listing on the contents of the "Name2®, "Post-Code” or
"Notes” ficlds. Choose the sort option you want by clicking one of the
boxes, then press . You should see that your Address Book is now listed
in the order you chose.

When sorting alphabetically, numbers are listed before letters. Entries
which contain no information in the chosen field will appear at the end of
the list.

import
You can usc this command to add information from an address book which
you have created on another computer into your PcW 16, 10 save time
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retyping the names and addresses. For example, if you have an Amstrad
NC200 notepad computer, you can usc this command to transfer your
existing NC200 address book into your PcW16. You can also Import data
from a "CSV" or "Comma-Scparatcd Valuce® file - this can be created usi
a PC-compatible or other type of computer, and can contain names and
addresscs in a similar structure to the PcW16's Address Book.

When you select the Impornt command, you first have to choose whether
you are Importing from a CSV-format file, or from an Amstrad NC200
Address Book:

Click the box for the option you want, insert the disc containing the addre
book file in the drive, then press /. If you are importing a CSV file, the
program displays a dialog listing all the files on the disc (see below).
Sclect a file to import from the list, then press /.

Notes on Importing CSV files

If the file you want is not in the lIst, it is not stored in the DOS "Root”™
directory of the disc. CSV files can only be Imported from a disc’s root
directory, not from sub-directonics. When using a different computer to
crcatc a CSV file for importing into the PcW 16 spreadshect, ensure that t
file is stored in the Root directory.

When you are Importing a CSYV file, the address data cannot be guarant
to fit properly into the PcW 16’s Address Book unless you have made sure
that the progmm which created the file used the correct format. There are
many variations of CSV file, so 10 ensurc that CSV data is imported
correctly, the source program must be configured to store the "ficlds”™
(Namel, Name2 eic) in the same order as that used on the PcW 16's Ad-
dress Book screen, and to include blank ficlds where there is no equivalent
ficld in the source data.

As a precaution, before importing a file, we recommend that you makea
copy of the Cabinct on a floppy disc, using the Backup Cabinect 1o Disc

l
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command in the File Manager. If the file you import causes a problem, and
you want to revert back to your original address book, you can then Re-
store the Cabinct from the disc in the File Manager.

Export
You can use this command to save a copy of your Address Book onto a
floppy disk. The address book is stored as a CSV file, so that it can be
Imported into the Address Book on another PcW 16, or used by other
programs on other types of computer. The Address Book file is stored in
CSV format,

When Exporting, insert the disc before selecting the command. When you
then sclect Export, the program displays this dialog:

Type a name for your Address Book file, then click /.

Note that the filename you type must be compatible with DOS - sec appen-
dix F, on DOS compatibility, for more information. 1f you do not add a
suffix to the file name, the suffix *.CSV™ will be added automatically.
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The Entry Menu

The commands in this menu deal with individual Address Book Entrics.

Add New Entry

Go

This command is also activated by pressing the BLUE key. You must use
il every time you want fo add a new enliry to the book.

When you select the command, you will sec that the "Entry” panel on the
left of the screen gocs blank, and the cursor flashes in the "Namel " ficld.,
Type the sumame for the new Entry, then press [Retum]) to move down to
the "Name2* ficld. Continue typing and pressing [ Returmn] until you have
cntered all the information you want to include in the Entry.

The new entry is displayed in the list on the right of the screen as soon as
you sclect another command, or when you press [Retumn] when the cursor
1s in the "Notes” ficld at the bottom of the Entry.

To Initial Letter
This command cnablcs you to move quickly to any initial letter in the
Address Book list. The command displays this dialog:

& o - —

For example, if you want to find the first entry in your book with the
NAME]1 field beginning with S, sclect Go To Initial Letier and type S, the
click OK or press /.
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Delete Entry
This command is also activated by pressing the RED key. It deletes the
entry which is currently displayed in the "Entry” pancl.
To delete an entry, first choose which entry you want to delete from the list,
using the T4 keys or by clicking with the mouse, then click the Delete
button or press the RED key.

(vEs - DauiTe < QO w0 - Casciu BN sELp

This dinlog asks you to confirm that you want to delete the entry - when
you press /, the entry is deleted from the Address Book

UNDO

If you delete an entry by mistake, you can usually retrieve it by pressing
UNDO.

Find Entry
This command is also activatced by pressing the YELLOW key. Youcan
use it to search through the Address Book for a particular name, address,
number. or any other picce of text which appears somcwhere in the entry.
When you choose the Find command, the program displays this dialog:

Type in the text you want to scarch for, then press /. The program will
search through all the ficlds in all the entries - when it finds the text you
have entered, it will display the entry containing that text in the "Entry™
pancl. The program searches all the ficlds, so the text can be found any
part of the entry; name, address, phone numbcr, notes ctc.
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The Diary / Alarm

The Diary Screen

The Diary screen has two main panels: the Calendar panel and the Ap-
pointments pancl,
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The Calendar Pancl
This opemtes just like a normal calendar, except that it can show the days
of the week for any year you choose. You can move the calendar display
forwards or backwards by a month or by a year, using the & and B buttons
al the bottom of the calendar. When you choose different day in the calen-
dar, that day’s appointments are shown in the Appointments pancl.
Below the Calendar is 2 Clock, showing today’s date and the current time.
This shows the real timne, as set by the PcW16's intemal clock.

The Appointments Panel
This acts rather like a diary page. By default it shows a whole week, but it
can be changed to show just onc day - this is useful il you want to enter
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several appointments for a single day, because it provides more space for
showing cach day’s appointments, and their messages. For example, if't
Appointments panel shown in the illustration on the previous page were
switched to Single Day mode, it might look like this:

* "
Sl Ty
e thewes

B lovrn Fago B

Each Appointment appears as a line of text. If it is a timed appointment
(sec Add Appoiniment below), its ime is displayed beside it, and if it has
the Alarm option sclected, it also displays a small "4 bell symbol, like t
“08:00 Wake Up” appointment shown above.

This allows you to sec all the appointments and alarms for a particular da
at a glance.

Using the Diary
You can use the Diary / Alarm like an ordinary paper diary - it has a page
for each day (or it can display a whole week on a single page), and you
wrile up to 16 "Appointments” into cach day. The program's Calendar
display shadcs all the days which have appointments in them, and you can
use the calendar to move quickly from month to month and year to year.
You can also move forwards and backwards through the diary by clicking
the B and BX buttons at the bottom of the Appointments panel. This mow
you forwards or backwards by one wecek or onc day, according to whether
the Appointments pancl is working in Week or Day mode.
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The Appointment Alarm
The program has an Alarm facility - you can cnler a time for your appoint-
ment, and when that time is reached. your PcW 16 will display the appoint-
ment on the screen, and flash the "Appoiniments”™ light at the top right of
the keyboard. You can also choose the "Audible Alarm® option, so that the
PcW 16 makes a beeping noise to attract your attention at the appointment
time.
Note that the appointment alarm will sound, and display the message you
typed in for your appointment, cven if you are using a difTferent program
(say the Word-Processor) at the appointment time. The alarm will even
operate when the PcW 16 is in "Standby"” mode, switching the computer on
and displaying the message for five minutes before switching ofT again.
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The Date Menu
The commands in the Date menu moves the Appointments page to display
different days.

Show Today
This command switches the Appointments display to show "Today™.

Go to Date...
This command allows you 1o enter a datc, cither by typing a new date or
using the “Spinner”™ buttons to move the date forward or back. When you
press , the Appointments display moves to the date you have chosen.

Show Next Appt
This command scarches forward from the current appointment or day until
it finds the next appointment. It then moves the Appointments display so
that it highlights the next appointment.

Day + and Day -
These commands move the Appointments display forward or backward by
onc day. You can also usc the [T] and [{] keys to do this.

Week + and Week -
These commands move the Appointments display forward or backward by
onc week. [fthe Appointments display is set to "Week™ view, you can also
usc the [«-] and [-»] to do this.

Month + and Month -
These commands move the Appointments display forward or backward by
onc month. You can also use [Shift]+{<-] and [Shift}+[—] to do this.

Year + and Year -
These commands move the Appointments display forward or backward by
onc year. You can also use [Ctri]+[Shift)+[«] and [Ceri]}+{ShiR]}+[—] t0
dothis
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The View Menu

show Day and Show Week
These commands sclect whether the Appointments display shows a single
day, or a whole week. The Show Day command makes the Appointments
display show only a single day. while the Show Week command switches it
to show 7 days.
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The Appointments Menu
These commands are used to add, change or deletc appoiniments.

Add New Appointment
When you select this command, the program displays a sequence of dia-
logs, into which you can enter details of the appointment you want to mak
There arc five picces of information you can enter for cach appointment,
and cach displays a separate dinlog. At any point in this sequence, you
click the FINISHEDY button to accept all the appointment scttings, or
can click the MORE¢] button 1o move to the next dialog. The five dialogs
Srt:

The Appointment Message
This is the text which is shown on the Appointments display, though if the
appointment text is quite long. you may only be able to see the first few
words. If you choose the Alarm option (sec below), the Appointment

Message is also displayed on the screen when the alarm time is reached.

Appointments Without Times
Note that if you simply want 1o make a note about the day in general, you
can just type the appointment message and press FINISHEDY to create an
appointment which does not have a time or alarm. Appointments with no
time details appear at the top of the display for cach day, before the carliest
timed appointment.

The Appointment Time

This time 15 shown beside the Appointment Mcessage. If you choosce the
Alarm option (sec below), this is the ime at which the alarm will go ofT.

The Appointment Date

By default this will show the currently sclected day in the Calendar, but
vou can change it by typing a new date, or using the spinner buttons to
move the date forwards or back.

The Repeat Options
You can makc a single appointment appear at regular intervals, at the sa
time every day, every week, every month of every yvear,

The Alarm Optlions

Y ou can choose whether or not the PcW 16 displays an alarm at the ap-
pointment time. Note that you need 10 use the Options command (sce
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below) to choose whether the audible alann will sound, and whether the
PcW16 will “wake up” from Standby mode to display the alarm. Sce
Opions below.

tdit Appointment
Whenever the Appointments display shows any appointments, one of them
will always be highlighted. You can use the Edit Appointments command
to alter the details of this appointment. To highlight a differcnt appoint-
ment on the same day, usc the [ 7] and [{] keys.
The Edit command lets you change any or all of the details you entered
when you first Added the appointment, and it displays exactly the same
dialog sequence as the Add command detailed above. Atcachdialog. if
you just press [Return), the old details will be retained.

Delete Appointment
This command simply deletes the currently highlighted appointment. Note
that if you delcte an appointment by mistake, you can use the UNDO key
(or click on UNDO in the menu bar) to retrieve it, as long as you have not
used any other commands in the meantime.

Options
The Options command displays the following dialog:

The Alarm Options boxes allow you to control what happens when an
alarm goes ofT. If the PcW 16 is switched on, it will always display the
appointment message, and will not let you continue until you to press the
key to confirm that you have scen the message. There are two other alarm

options:
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The Sound Beeper option makes the PcW 16 sound an audiblc alarm at t
appointed time.

The Wake up from Standby option only operates if the computeris in
Standby mode when the appointment time is reached. 1fthe option is
sclected, the Pc W16 will switch itsclf on automatically, display the alarm
{and sound the beeper if sclected), and wait for you to acknowledge the
alarm.

If the alarm is not acknowledged after 5 minutes, the PeW 16 switches itse
back into Standby mode.
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The File Manager

Why Do | Need a File Manager?

Your PcW16 only contains a limited amount of storage space - afler you
havec been using it for a while, the "Cabinet” is likely to become full, and
you will need to clear some files out onto floppy disc. It's also a good idea
to make "backup” copics of your documents and filcs, in case anything
goes wrong with the Cabinct storage inside the PcW 6.

The File Manager program allows you to see the files stored in the Cabinet
and on disc, and to copy. move and delete them. There is a special
~Archive” command, which automatically selects the oldest files in the
Cabinet and moves them onto a floppy disc. The File Manager also in-
cludes Backup and Restore commands, for making a backup copy of the
entire Cabinet, including the Address Book.

The File Manager Screen

When you first sclect the File Manager program from the desktop, the
screen Jooks meﬂting like this:
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At the top of the screen, below the menu bar, are three large buttons -
arc used for fast access to the Copy. Archive and Delete commands. The
is also a Stop buttion, which is used to quit from the File Manager and
return 1o the Deskiop. Below, there is a panel showing the contents of the
Cabinct.

On the left of this panel. there is a list of all the Folders in the Cabinct.
One Folder is sclected - in this case, "Folder01®. The files in the selected
folder are listed on the right.

File Type Indicator

As well as the name of the file, the list also shows the time and date at
which the file was last saved, and the file size. Just to the left of the file
name, there is a small symbol, usually ] or [8] - this indicates which pro-
gram was used to create the files. [8] indicates that the filc is a Word-
Processor document, while [§] indicates a Spreadsheet file. Other symbols
arc uscd for other types of file, but these are stored in the System folder,
and you will not normally see them.

File Size Indicator
The size of a computer file is measured in Bytes, so a file which has, say,
size of "250" is 250 bytes long. Because files can contain many thousands
of bytes, larger sizes are measured in "K", or Kilo-Bytes. Each Kilo-Byte
is 1024 bytes. When the File Manager program reports the size of a file
"10K", this mcans that the file is (spproximately) 10x1,024 or 10,240
bytes in size.
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Using the Floppy Disc
The File Manager screen can also be split, so that you can see the contents
of the floppy disc as well as the Cabinct. To scc the contents of & floppy
disc, put the disc in the drive, and press [Ctrl]J+({L], or click the mouse right
button. The computer scans the disc 1o find out what files it contains, then
displays the disc and Cabinct contents like this:
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In this illustration, the disc’s Folder01 contains the same files as the
Cabinet’s Folder01. Two of the files on the disc are also “Sclected” - see
below for more information about Selecting files.

—
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The File Menu
The commands in this menu are used to manipulate individual files, or
groups of files.

Selecting Files...
Commands such as those used for Copying, Moving and Deleting files onl
operate on files which are “Sclected” before the command is used. Files
which are "Selected” are shown as white-on-black in the file list. You
cannot sclect Cabinet and Disc files at the same time, and you cannot sel
files which are not visible on the screen.

~.with the Mouse
You can select a file by clicking on it with the mouse - click again and the
selection is cancelled. To change Folder, click oa the name of the Folder
you want.

-..with the Keyboard
If the screen is split to display both the Cabinet and the Floppy Disc, use
the {Tab] key to switch between them.
In the Cabinct and Disc pancls, the [T] and [{] keys are used to sclect both
the Folder and the Files - first use T4 1o move the sclection up and down
the list of Folders, until the Folder you want is highlighted. Then, press the
[—»] key - the [T] and [{] keys now move through the list of files. Move
the box over the filename you want to select, then press [Spacce] to select
the file. Pressing [Space] again de-selects the file.

Using the File Commands
Once you have sclected the file(s) you want, choose what you want to do
with these files by selecting a command from the "File® menu. If you want
to Copy or Delete the files you have sclected, you can click the Copy

burton (press Blue) or the Delete button (press Red) instead of choosing
these commands via the File menu. Sce below for a more detailed descrip-
tion of how to usc these commands.
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Copy File(s)
This command copics the currently selected files to a different location.
You can copy files between the disc and the Cabinet, and you can choose
which Folder 10 copy into. The command displays the following dialog:

You must first choosc whether to copy the selecied files to the disc or the
Cabinet - do this by clicking on the Cabinet or Disc boxes, or by pressing
[Tab) repeatedly until the box you want is highlighted, then pressing
[Space].

INext, you must choose a Folder in the location you have selected. One of
the Folder names is shown, but you can change this by clicking on the 3
symbol and choosing a new Folder from the list. Press / to confirm your
sclection and begin copying.

Move File(s)
This command works in cxactly the same way as the Copy command
abave, and uscs the same dialog. The only difference is that instead of
making copies of the sclected files in the new location, it moves the files
from the old bocation to the new one.
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Rename File
This command lets you change the name of a file. When you select it, it
displays a dialog showing the name of the selected file:

Simply type a new name for the file, and press ¢ to confirm.
1f you had sclected more than one file when you chose the Rename com-
mand, the program sutomatically displays the Rename dialog again, this
time with the name of the second file in it. When you type a new name for
the second file, the program automatically shows you the third file, and so
on until all the files you selected have been renamed.

Delcte File(s)
This command aliows you to delete the selected files. When you select a
group of files and choose Delete, you will see this dialog:

To make sure that you don't delete files by accident, this dialog lists the
files you have sclected, and asks you to confirm that you definitely want to
delete them. To delete all the files in the list, click the SELECT ALL
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button (or press [A]), then the DELETE SELECTED FILE(S) button (or
press [D]).

Altematively, you can sclect files individually by selecting them (using T
and [Spacc])). and Delete the files as required.

When you have deleted all the files you do not want, press / to finish.

select All and De-Select All
These commands are simply short-cuts to selecting or de-sclecting all the
files in the currently active Folder,

Change Default File Storage
When you create a new document or spreadsheet, the program automati-
cally suggests a location for the file (though you can always change this
location at the time you create the file). By default, this location is
FOLDEROI in the Cabinet. but you can use the Change Default File
Storage command to alter the automatic suggestion to a location of your
choice. Using this command has no obvious effcct: you will not sec the
new default location until you next use the word-processor or spreadshect
program.
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The View Menu
The View Menu commands affect the File Manager’s screen display only -
they do not alter the content of the Cabinct or the Disc in any way.

List Order
In the Cabinct and Disc pancls, the files in each Folder are shown in a list.
This list can be ordered in three diffcrent ways, and this command is used
to change the list order.

The files can be listed by name Alphabetically, or by Size (largest first). or
by Date (inost recent first).

Show Cabinet System Folder

As well as the sixteen normal Folders which always appear in the File

Manager pancls, the Cabinct also has a special folder called the System
Folder. This is used for storing files which are used by the computer’s

opcrating system and programs - such files include the information inthe
Address Book, the Templates and Fonts used by the Word-Processor, and
the Configuration information you enter when you first use the computer.
You can use this command to include the System Folder in the File Manag-
cr's Cabinet display, so that you can see the files stored in it. However, it i
very important to understand that the files in the System Folder are cssen-
tial for the proper operation of your PcW16 - if you delete or change any o
them. your system may not work properly. DO NOT MAKE ANY
CHANGES TO THE FILES IN THE SYSTEM FOLDER UNLESS
YOU KNOW EXACTLY WHAT YOU ARE DOING.
This command is a “Toggle”. If the System Folder is hidden, the command
will display it. Ifit is alrcady displayed, selecting the command again will
hide i1.
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show Disc Folders
This command splits the screen, and shows the contents of the Floppy Disc
folders in the bottom panel. The command is a "Toggle” - if the "Disc”
pancl is already visible, selecting the command again will remove il.
You can also display the disc contents by pressing [Curl}+{L], or by click-
ing with the mouse right bution.

Show Disc System Folder
This command can be used to show the contents of the System Folder on
the floppy disc. All the discs you format on your PcW 16 have a System
Folder, but it is not normally used for storing files, unless the disc is used
to make a Backup of the entire Cabinet. Sec Backup below.
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The Cabinet Menu

The commands in this menu apply specifically to the Cabinet and its
contents.

Folder Names

This command allows you to change the names of the Cabinet Folders -
default names are FOLDERO!, FOLDERO2 etc, but it is sometimes useful
to change these names, especially if you use a particular folder fora
particular type of filc. For example, if you usc the word-processor to wrile
lctiers and invoices, you might want to keep these in separate folders, and
to call the folders "LETTERS™ and "INVOICES". The Folder Names
command displays the following dialog:

The dialog contains a drop-list of the current folder names, and a box for
typing the new name. Click on the E¥symbol to display the list (or press
[Tab] repeatedly until the Kl symbol is highlighted. then press [Space]),
then choose a folder name to change from the list. Next, type the new
name for the folder, and press / to confirm.

IMPORTANT NOTE: Folder names cannot be more than cight characters
long, and can only include the letters A-Z and numbers 0-9. They cannot
contain spaccs, punctuation characters, or accentcd characters.

Archive

This command provides an automatic method for cleaning out the oldest
files from your Cabinet folders, and moving them onto a floppy disc to
make more space available in the Cabinet.

When you select the Archive command, it analyses the Cabinet to see how
much free space there is, and if archiving is necessary, the program works.
out how many filcs need 1o be removed. If you choose the command while
there is still plenty of space left in the Cabinct, the program will inform you
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that Archiving is not nccessary. If Archiving is necessary, the program will
ask you to insert a disc, and tell you the date of the newest files which will
be removed from the Cabinet.

Note that because Archive is intended to be a simple and automatic proc-
ess, the command docs not allow you to select individual files for archiv-
ing. If you want to sclect "by hand™ which files to archive. usc the Move
command instcad.

Backup Cabinet to Disc
This command makes a complete duplicate copy of the contents of the
Cabinct on a floppy disc. In doing so, it crases any data which was previ-
ously stored on the disc, so you must ncver backup onto a disc which
contains files you want to keep.
Backing up is an important process for computer users, and we recommend
that you take a complete backup of your system ot regular intervals. You
can rcuse the same discs for backups as many times as you like, but we
reccommend that you keep three generations of backups - in other words,
reserve three different floppy discs exclusively for backing up, and every
time you do a new backup, usc the disc containing the oldest backup, so
that the old backup is over-written. This means that even if somcething goes
wrong during the backup process. you still have two full backups of the
Cabinet conlents.

Restore Cabinet From Disc
This command is uscd to Restore the contents of the Cabinct from a
Backup disc. Note that when you Restore, all information stored in the
Cabinet is over-writien, and cannot be recoverced. Only usc the Restore
command if you have experienced a "Fatal Error®, and had to restant your
PcW 16 using the Rescuc Disc.
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The Disc Menu

The commands in this menu apply specifically to the Floppy Disc and its
conicnts.

Folder Names
This command allows you to change the names of the Folders on your
Floppy Disc. It operates in exactly the same way as the Folder Names
command in the Cabinet menu - sce previous page for details.

Format Disc
This command formats or re-formats a floppy disc.
Floppy discs must be formstied before they can be used for storing files. L
you buy a box of new discs, you will find that you cannot usc them with
your PcW16 (cven if they appear to be "Pre-Formatied™) until you have
used the Format command to create the PcW 16's Folder system on the di
For more technical information about disc formats, sce appendix F.

Duplicate Disc
This command makes a copy of onc floppy disc on another floppy disc. It
copics the entire disc, including all the folders and files. Note that any files
already stored on the destination disc (the one you are copying onto) will b
destroyed in this process.
The Duplicate command does not affect the Cabinet in any way.

Change Disc
You should use this command to tell the File Manager program if you
change the disc in the floppy drive. 1t forces the program to scan the new
disc, and updatc the Folder and file lists in the Disc panel.
You can also click the mousc right button to force the program to scan the
floppy disc.
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Appendix A:
Safety and Cleaning Instructions

Health Concerns - EC Directive 90/270/EEC
There are certain minimum health and safety requirements which relate to
working with computers. These requirements are set by the Display Screen
Equipment EC Directive 90/270/EEC and employers must comply with
them. The following informetion is extracted from the Health and Safety
Executive’s “Guidance on Regulations 90270/EEC™,

Upper Limb Pain and Discomfort

Conditions of arm, hand and shoulders linked to display screen work, range
from temporary fatigue and soreness to occupational cramp and to chronic
soft tissue disorders such as inflamed tendons or carpal tunnel syndrome.
AVOID prolonged static posture, awkward positioning of the hands and
wrists and high workloads and tight deadlines.

USE proper equipment and furniture. Always follow correct training,
Design job and workload to incorporate other tasks or breaks away from

the display screen. Consult your doctor if you experience soreness, pain or
discomfort.

Eye and Eyesight Effects

Users may experience temporary visual fatigue such as impaired visual
performance red or sore eyes, headaches, or the adoption of awkward
posture which can lead to upper limb disorders.

AVOID poor positioning of equipment, poor legibility of screen or source
documents, poor lighting including glare and reflections, drifting. Mickering
or jittering screen.

Take appropriate cyc and sight tests regularly. Clean the screen and
inspect equipment for maintenance regularly. Report any equipment
malfunction immediately.

Fatigue and Stress

Many symptoms described by display screen workers reflect stresses
arising from their task.

Stresses can arise from poor job design or work organisation. Lack of
sufficient control of the work by the user. Under utilisation of skills. High
speed repetitive working or social isolation.
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Avoid stress by ensuring good design of workplace, environment and task,
Equipment should be carefully selected and positioned. Train, consult and
involve the user.

Safety instructions ,
Your PcW16's clock is powered by an intcmal NiCad battery which needs
to be charged. The first time you switch on leave the PcW 16 connected to [
and switched on at the mains power supply for 2 hours (the Standby button
on the front can be swilched ofY) this will charge the NiCad. Youcanbe
using the PcW 16 while charging is taking place. You may need to repeat
this procedure if the PcW 6 has been disconnected from the mains for a
prolonged period.

ALWAYS switch off using the STANDBY BUTTON on the front of your
PcW16, or the "Switch Off” command in the Tasks menu. NEVER switch
ofT by disconnecting from the power supply - you may losc the work you
have donc. Only disconnect the power when the Standby button glows red,
not while it s flashing.

Safety

When choosing a position for the computer make sure that all the equip-
ment is installed close to, and within easy access of|, the electrical mains
supply socket.

Make sure that the equipment is not situated near an artificial heat source,
such as a radiator, ncar a water supply, in direct sunlight, nor in a humid or
damp atmosphere. These clements can damage your computer and destroy
data. Avoid a location where the computer will be exposed to dust, dir,
vibration, cxcessively high or low temperatures or rapid changes in tem-
perature. The operating lemperature specification for this computer is
between 10°-35°C.

When not in use your PcW 16 should be switched ofY at the mains power
supply. However, if you want the alarm 1o operate in *Wake-Up™ mode,
you must leave the PcW 16 in Standby mode.
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Sensible Safety Precautions.

Switch ofT the computer completely and disconnect the power plug (by
pulling the plug, not the cord) if any of the following conditions exists:

* the power cord or plug becomes frayed or otherwisc damaged

« vou spill something into the case

= your computer is exposced to rain or any other excess moisturc

* your computer has been dropped or the case has been otherwise damaged
* you suspect that your computcer needs service of repair

* you want to clean the casc

Cleaning your PcW16
When cleaning your PcW 1 6, please obscrve the following points:
» Switch ofY the computer completely and disconnect the plug (pull the
plug not the cord).
» Don’t use acrosol sprays. solvents, or abmasives,
* Do not get moisture in any of the openings.
« Use a soft, lint-free cloth dampened with water for the cabinet.
e Use houschold glass cleancr on a soft cloth to wipe the screen.
* Do not spray any liquid directly onto the cabinet or screen.

Cleaning the Mouse
If the mouse movement becomes jerky. this may be duc to dirt accumulat-
ing on the moving parts inside the mouse. To clcan these, you must remove
the rolling ball as follows.
First, turn the mouse over and twist the collar around the ball anti-clock-
wisc. Tum the mousc over again so that the ball falls out. You can now
clcan the ball with a soft cloth. Inside the cavity where the ball is normally
located, you should be able to sce two black plastic rollers. You should
remove any dirt or debris from the surface of these rollers.
When you have cleancd the mousc's moving parts, drop the ball back into
the bole, and replace the collar.
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Appendix B:
Replacing your PcW16’s Mains Plug

Fuse
The Mains lead supplied with this equipment is fitted with a standard 13
amp plug (BS 1363) and is fitied with a § amp fuse. When changing or
cxamining the fuse, the correct S amp fuse - ASTA or BS| approved (BS
1362) must be fitted and the fusc cover replaced. If the fuse cover is lost,
the plug MUST NOT be uscd until the correct replacement fuse cover is
obtained from the manufacturer (see the beginning of this manual for
details of how to contact Amstrad Direct).

Plug Type
The |3 amp plug is the most widely used type in the UK and should be
suitable for most users. However, some locations (mainly older buildings)
may not be equipped with normal 13 amp sockets. In such cases it is
recommended that a suitable plug adapter be purchased from vour dealer
(rather than remove the moulded plug). However, should you decide 1o
change the plug. please follow the instructions below.

Wiring
The wires in this mains lead are coloured in accordance with the following
code;
e  Green-and-Yellow - Earth
* Bl - Neutral
e Brown: - Live

As the wires in the mains Jead of this apparatus may not correspond with
the coloured markings identifying the terminals in your plug. please pro-
ceed as follows:

The wire that is coloured green-and-yellow must be connected to the
terminal which is marked by the lctter “E” or by the safety earth symbol...

o

-..or coloured green or green and }tllo;v.
The wire that is coloured Blue must be connected to the terminal which is
marked by the letter “N™ or coloured black.
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The wire that is coloured Brown must be connected to the terminal which is
marked by the letter “1.” or coloured red.

A S amp fuse must be fitted cither in the plug or adapter or at the distribu-
tion board.

WARNING
THE PcW16 UNIT CONTAINS LIVE PARTS INSIDE - DO NOT
REMOVE ANY SCREWS. THE UNIT MUST BE EARTHED.
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Appendix C:
Printers and Compatibility

You can usc a range of different printers with your PcW16. The very first
ume you first switch the unit on, it will ask you which type of printer you
are using, and will then configure itself correctly for the printer you choose,
Note that if the nume of your printer is included in the printers list, you
should always sclect it - do not choose a “compatible” option unless
your printer does not itself appear in the list.

If you want to usc a printer which is not included in the list of printers
specifically supported by the PcW 16, you may need some help choosing
the correct option,

Note that all printing from the PcW 16 is in "Graphics Mode™, even when
you are printing text from the word-processor, so your printer must be
capable of printing graphics. This means that a Daisy-Wheel printer
cannot be used with the PcW16,

Essential Printer Jargon
To use this section. you will need to understand a couple of special techni-
cal terms about printers.
The first is the printer’s Resolution, usually a measure of its print quality.
A printer’s resolution is the numbser of dots it can peint in a given arca, and
it is normally measured in Dots Per Inch, or "DPI”. The higher the DPI,
the more detail you get in the printout. The PcW 16 can print at two
difTerent resolutions: 300dpi and 360dpi.
The sccond term is Emulation. Instcad of making every printer unique,
manufacturers usually make cach new model emndare, or behave identically
10, an carlicr onc. This means that if you cannot select your own particular
printer by name. you can instead sclect a printer which it emulates. For
example, most laser printers emulate the HP-Laserjet, so if you havea
laser printer which is not specifically supported by the PcW 16, you may be
able 1o make it work by selecting the HP-Laserjet printer option. Each type
of printer listed below includes a description of the commonly emulated
printers in cach category. Printers which emulate other printers arc also
described as compatible with them.
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Printer Types
There are three basic printer types which you can use with your PcW16,
though not all printers of cach type will necessarily be compatible. The
three types are:
Laser printers - such as the HP-Laserjet serics:
Inkjet printers - such as the Canon Bubblejet or HP-Deskjet scries;
Dot-Matrix printers - such as the Epson LQ series (and many others).

Laser Printers
To operate with your PcW 16, a Laser printer (or LED printer) must bo
capable of 300dpi resolution, and be compatible with the HP-Laserjet
standard to PCL level S. You do not need to know what this "PCL"
number means, but you should be able to check with your printer supplier,
or in your printer manual, that your printer fulfils this specification.
Note that you cannot usc a Postscript laser printer, or Windows GDI
printer, with your PcW16. Some laser printers allow selection of Post-
script or GDI and HP-Laserjet (or “PCL") - if your printer is capable of
both modes. make sure that it is set to Laserjet mode, not to Postscript or
GDI mode.
If you are using an OKI LED printer, you should always select the appro-
priate OKI printer type, not the Laserjet PCL option.

inkjet Printers
Inkjet printers can operate at cither 360dpi (the Canon Bubblejet and
compatibles, and the Epson Stylus printers). or 300dpi (the HP Deskjet and
compatibles).
Canon Bubblejet
Apart from the Canon BJ-30 (which you can select specifically), most
Bubblcjets can operate in two different emulation modes, called
*Epson LQ" and "Canon BJ” emulation. See your printer manual for
details of how to set the printer mode.
You can use any of the Canon Bubblejet series printers with your PcW16.
The BJ-30 has its own specific option in the selection list, but for the other
Bubblejets, sclect the "Canon Bubblejet™ type, using the "BJ” or "LQ"
option depending on your printer’s emulation setting. Note that you will
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normally achicve the best print quality from a Canon Bubblejet if you
operate the printer in BJ mode.

Epson Stylus

If you have an Epson Stylus printer, or one which is compatible it, you
should sclect the "Epson Esc/P2" option in the list of printers.
Hewlett-Packard Deskjet

The HP-Deskjet range of inkjet printers operate at 300dpi. The PcW16
only supports HP Deskjet series with model numbers above 500, and does
not support the Deskjet S00C model. If you have a Deskjet 500 or higher,
choose the option for "HP Deskjct and compatibles™ in the list of printers.

Dot-Matrix Printers
The PcW 16 supports two general types of dot-matrix printer: the
“Epson LQ" type, and the "IBM X24E" typc. Note that these arc both
24-pin printer types: the PcW16 does not support any 9-pin dot-matrix
printers.
Most 24-pin printers will emulate one or both of LQ or X24E systems, but
you must make sure that the printer is switched to the same emulation as
the onc you sclect in the PcW16's Printers list. For example, a printer
which supports both LQ and X24E modcs will not work if you sct the
printer to 1.Q mode, but sclect the *X24E and compatibles™ entry in the
PcW16's Printers list.
A few carly 24-pin printers will not work peoperly with the L.Q or X24E
option. If you find that you cannot print using cither of these emulations,
ry sclecting the "1.Q1500 printer option.
For details of how to set your printer's emulation, please sec your printer
manual.
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Appendix D: Dialogs and the Keyboard

If you want to avoid using the PcW 16's mouse altogether, you can operate
all of the Mcnus, Commands and Dialogs using only the keyboard. In-
structions for operating the Menus and Commands using the keyboard are
given in section 8 of the Beginners Guide chapicr.

Dialogs are more difficult to operate with the keyboard. As an illustration
of the problem. have a look at this dialog, which is used for setting the
Paper Size in the word-processor:

With the mousc, you can simply click on each option 1o change its value.
With the keyboard, it is not immediately obvious how you change the
options, or how you choose which one you want to change.

Tab and Space: the "Focus”
The key to operating dialog with the keyboard is to use the [Tab) and
[Space] keys. When a dialog is displayed, one of its objects always has the
“focus” - the focus is indicated by an outline around the object, and it
mcans that you can activale the object by pressing [Space]. If you look
carefully at the illustration, you should scc a dotted outline around the OK

button:

This outline indicates that the OK button has the "focus”, so pressing
[Spacce] at this point would perform the same function as clicking with the
mouse on the OK button.

Pressing [ Tab] repeatedly moves the focus around all the dialog objects in
tum. You can sec how this works by displaying any dialog on the screen,
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and pressing the [Tab] key - you should see the "focus® highlight moving
around all the different dialog objects in turn.

In the Paper Size dialog. for example, pressing [ Tab) once moves the focus
to the Cancel button. So you can cancel the dialog by pressing [Tab) once,
then [Space). Pressing [Tab] twice moves the focus to the Help button.
Pressing it a third time moves the focus to the "A4” option box, which now
appears outlined in white:

You can continue pressing [ Tab] to move the focus highlight onto any
object in & dialog, and using [Space] to activate the focused object.
Shift+Tab .

You can also use [Shift]+[Tab} to move the focus back through the objects.
If you press [Tab] too many times and step past the object you want, you
can press [Shift]+{Tab] to step back to it.

Using Other Keys

Once you have moved the focus onto a particular object, you may be able
to use other keys to change the object’s scttings: in the Paper Size example,
once you have moved the focus onto the Paper Height or Paper Width
spinners, you can use the T4 keys to increase or decrease the settings.
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Appendix E:
The PcW16 Character Set

This grid shows all the characiers and accents you can type and print using
the PcW16's word-processor, and the "codes™ used to represent them in the
PcW 16 operating systcem. In the table below, the codes are shown ina
standard character grid format, in hex notation: in the range ¥20-#7F, the
sct is ASCll-compatible.

Note that the codes arc not contiguous: there are no characters in the range
#B0-#EF.

2 F

(accents)
—  Grave
e Aculc
. Umlawm
°  Tilde
X  Hacek
7 Ring
t+ Circumflex
3
A
®
Y

Loy
&
w
=/
=y
(s <]
w
p -]

Space

Lwue
|
L

Over-Dot
Macron
Breve
Double-Acute
¥  Apostrophe
Ys  Under-Dot
i Comma
« Cedilla

} _ » Ogonck

Most of the characters from #7F upwards are not printed on the keys - see
the next section for a guide to typing the extra characters.

OO YO WVidawWih=—=0Q

* owrm o Pm

L

TMTMOOTPOEBNDIVLWN=O

CZIrAR =0 TmOo 0O ®>Mh)
Y s NL R ECCHNRBO T

09 3 =rreuare 00 00

v | wemem N X f L E =m0

T2 ecepnx0O -
#FxCmowIST O ¢

SV 0 OA e
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Typin

b eeopr=0@ !

v

Typing the Accents

Cule-
Sh+Curl+*
Cirl+2
Sh+Ctrl+)
She¢Ctri+K
Sh+Curi+ L.
Sh+Curl+Y
Sh+Ctrl+;
Sh+Cirl+G
Sh+Curl+D
Sh+Cul+H
Sh+Cirl+S
TaskseT
Tasks+4
Tasks+e—
Tasks+-»

FrOMSAITT O AR Me

g the Extra Characters

Sh+Curl+B
Sh+Curl+9
Crurl+9
Sh+Curl+ 8
Ctrl+8
Sh+Carl+\
Sh+Curl+ T
Sh+Cul+C
Sh+Ctri+Z
Sh+Curl+X
Sh+Cul+P
Curl+0

£
Sh+Curl+0
* {heypad)
Sh+Crurl+ Delete

= (heypad)

+ (Keypad)
Cuis.
Sh+Cul+#
Sh+Cri+Red
Sh+Ctrl+Green
Sh+Curl+|
Sh+Cirl+]
Sh+Crrl+/
Sh+Cul+R
Sh+Curl+E
Sh+Crurl+Q
Sh+Curl+W
Sh+Cul+1l
Sh+Crurl+,
Sh+Cirl+,

To type an accented character., type the accent first, then the character.

Grave
Acute
Umlaut
Tilde
Hacek

Ring
Circumflex
Over-Dot
Macron
Breve
Double-Acute
Apostrophe
Under-Dot
Comma
Cedilla
Ogonck

Tasks+*

Tnsks+1
Tasks+2
Tasks+3
Tasks+4
Tasks+5
Tasks+6
Tasks+7
Tasks+8
Tasks+9
Tasks+0
Tasks+-

Tasks+=
Tasks+#
Tasks+[

Tasks+]
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Appendix F:

Technical Notes on Discs and Filing

Although the PcW 16 disc appears to use a unique format (a fixed number
of folders, and support for 32-character filenames), this is really just an
extra layer of disc management which sits on top of a standard DOS disc
filing system. This appendix gives a bricf description of how this layer
works,

Note that the Import and Export commands in the Word-Processor and the
Spreadsheet can read and write files to and from the root directory of a
DOS disc, but DOS files and discs cannot be manipulated directly using
the PcW16’s File Manager.

Notes on Exporting, and DOS File Names
The word-processor, spreadsheet and address book programs all have
Export commands, which allow you to export a file onto a DOS disc for
use with a different computer. When typing DOS filenames, you should be
aware that the range of characters you can use {s very restricted, and the
length of the name must conform to the DOS standard.
DOS file names are composed of an eight-letier name, followed by a full-
stop, then a three-letter "suffix”. The Suffix is ofien used 10 indicate what
type of data the file contains - for example, files containing Comma-
Scparated Valuc data (as used by the spreadsheet and the address book)
normally have the suffix ".CSV". When naming DOS files, you should
ensure that include an appropriste suffix. Usually, if you type only the
main section of the name without adding a suffix, the Pc W16 program will
automatically add an appropriate suffix for you.
You cannot usc any spaces, punctuation or accented characters in DOS file
namcs. when Exporting to DOS files, ensure that the name you type is
compatible with all DOS systems by using only the letters A-Z and the
digits 0-9 in the file name.
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PcW16 Disc Directory Structure
When the PcW 16 formats a floppy disc, it uses the standard DOS format,
but creates an additional directory structure as follows:

‘-lHC:OT}
I—PCW
:
+—SYSTEM
+—FOLDERO1
I—FOLDERQ2

| ...elc

I—FOLDER16

The \PCW directory also contains a special file called CATALOG.TXT:
this is the file which cross-references the PeW 16°s 32-character filenames
to real DOS filenames, and contains additional information used by the
PcW16 filing system. When a PcW 16 program creates a file in a particu-
lar folder, the filc is stored in the corresponding directory under a DOS
name (eg PCW001.\WPD), and this name is stored in the CATALOG.TXT
file along with the 32-character file namc which was given by the user
when the file was created.

If you want to usc a DOS machine 10 access a file on a PeW 16 disc, you
must look in the CATALOG. TXT file to find the real name of the file, then
look in the Folder structure for the file itself. Note that the Folder names
can be changed by the user using the File Manager - the FOLLDEROI,
FOLDERO2 eic names are merely the defaults.

IMPORTANT NOTE
Although you may want to look at the contents of CATALOG.TXT to
cross-reference DOS and PcW16 lilenames, you should NEVER edit,
alter, copy or in any way rewrite CATALOG.TXT. If youdo, the
PcW16 will probably be unable 1o use the disc in future. Likewise, if you
want to copy a PcW 16 disc using a DOS system, you must use a Sector-
based copying system (eg DOS™s DISKCOPY program), rather than just
copying the file and directory structure. If you do not use a sector copier,
the resulting disc will probably not work with the PcW16.
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The System Folder
The System Folder on a floppy disc 1s normally only used if the disc is a
backup of the Cabinet. The Cabinct System Folder is used for storing al}
the PcW 16 system files, including the Diary and Address Book data files,
Fonis, Help files, word-processor Templates, and soon. Yon should never
delete files from the Cabinet System folder unless you know exactly
what you arc doing.
IT you do necd to make some space available in the Cabinet, however, you
can delete the Help files - these arc not cssential to the PcW16°s operation.

File Names and Suffices
The PcW 16 uses the file suffix of the real DOS name to determine the file
type. The types recognised by the PeW 16 include:

SYS aSystem file (cannot be deleted if located in System folder)
a WP document

a WP Template

a WP Template Template

a Spreadshect

a Help file

a word-processor bitmap Font file

FNF  afont family file

You should avoid using these reserved suffices if you are working directly
with files on PcW 16 discs.

358333
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Appendix G: Troubleshooting

Problem

Action

mscnt the Rescue [hse

The PcWI6 docy bot man wp ocomally,
but duplns a messsge sshing jyou 10

Insert the Rescue Duse m requensed If
you have cresied and stored files in the
Cabmet, they will Be Jost, %0 you wall

bave w0 Restore them from a Backup dusc

The screem does nol <ome on even

though the green light o on

Check and sdjmst the contrast and
brightness controls on the front of the unn

The mowse poinkes docs Bol @ove

The ménne pointer moves rkily

The keybomd does mot work

Check thmt the heyboard 8 canneceed to
the keyboard port om the back of the unat

The keyboard scerm to respond
wmcorrcctly

Try presssng the shift control mnd tmk keys
m tmm 1 ciear the problem

incorrectly

The prnter 06 @Ot pnnk or prots

Check that the prmtzr 13 connecicd 1o the
prinder port on the rem of the onit, m oo

The cdock or dmie m incorrect

Cannot find a filc ca 8 DOS dnc

Cannot Sclkect 2 Command from a
Dyop-Down  Mecno
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Glossary

Backing Up

Cabinet

Cell

Clicking on...

Column and Row

Discs

Glossary

Making a Backup copy of your work means making a
sparc copy and keeping it safe. When using a computer,
it is easy to lose your work, cither by deleting it acciden-
tally, or through a power interruption or some malfunc-
tion of the computer. Kecping a backup copy of your
important documents and files means that you can
retrieve your work if somcething goes wrong with the
original files.

The Cabinet is the PcW 16's own internal storage system
It performs two functions: firstly, it stores your word-
processor documents in "Files®, which you can group
into different "Folders™ to keep them organised.

Secondly, the Cabinet holds the programs, typefaces and
other information which your PcW 16 needs to function.
If the Cabinet malfunctions and becomes corrupted. you
may need to use your "Rescue Disc™ to make your
PcW16 work again,

The clements in a Spreadsheet are called Cells - they are
arranged in columns and rows.

Placing the mousc pointer over something on the screen,
then pressing and releasing the mousc lefl button (or
right button if the buttons have been reversed), is called
Clicking gn the object.

Spreadsheet cells are arranged in vertical Columns and
horizontal Rows. Sce¢ Introduction to the Spreadsheet,

page 97.

Your PcW16's disc drive uses standard 3%" Noppy discs,
which you can usc for storing files, and for transferring
your work between different computers. You should
slways keep sparc copies of your work on disc: see
Backing Up.

Amstrad PCWI(é
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Double-Clicking

Files

Floppy Disc
Folder

Greyed Out

Restore

Row

Toggle

The same as Clicking (see above), but the mouse button
is pressed and released twice in quick succession.

All computer information is stored in Files, but thisisa
technical matter which is not very important if you just
want to usc the word-processor. All you need to remem-
ber is that your word-processor documents are really
filcs, and you can move them around and make copies of
them using the File Manager program.

Sce Disc.

Pc W16 discs contain sixteen different Folders in which
you can store your documents and other files. Youcan
give these folders names to help you organisc your work.

Sometimes you will sec that a command appears dotted
and faint in a menu. This happens when the program is
in a particular situation which makes it impossible (o use
the command. Normally, commands which cannot be
used are greyed-out to indicate that they are unavailable.

When you usc the Backup command to make a complete
copy of the contents of your Cabinet. you can then use
the Restore command to copy the backup files back into
the Cabinet again - sec Backup.

See Column

A Toggle is a setting which can be cither on or off, and
which changes from onc to the other when you select it.
You can normally switch a toggle by clicking on it with
the mouse. For example, an option box in a dialog is a
toggle: click on it once to switch it on, then again to
switch it ofT. Some menu commands are Toggles, and
can be reselected to switch them on and ofT.

Page 162
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Index

3" PCW discs 67
A

Abandon Document 77
Abandon Spreadsheet 104
Accents 156
Add New Appolatment 128
Add New Ealry 120
Address Book 32, 117
Mail-Merging 76
Alarm 125
Alarm Opticas (Diary) 38, 128
Aligning Paragraphs 93
Alpbabetic Listof . 117
Apply Format (Spreadsheet) 107
Appoiatments (Diary) 37, 128
Appointments Without Times 128
Date 128
Message 128
Time 128
Archive 140
ASCIl
Exporting 68
Importing 66
Auto-Recalculate 110

Backing Up the Cabinet to Disc 141
Backing Up Your Work 44

Backup 44

Bold 62, 89

C

Cabinet 41, 13)
in the Word-Processor 64
Calculstor 40
Caleadar 13
Canon Bubblejet Printers 151

Cells
Sclecting 100
Cells (Spreadshect) 97
Numeric Formats 98
Text Formats 98
Centred Text 93
Change Column Width 107
Change Disc 142
Changing the Paragraph Formai 92
Changing the Tab Positions 91
Charncler Set 158
Check Speiling 73
Cleaning Page
OKI1 Printer 55
Cleaning the Computer 147
Clicking 14
Clock 13
Column Width (Spreadsheet) 107
Columns (Spreadsbeet) 97
Commands 46
Compatibility
Printers 150
Copy Sclection to Scratchpad
Spreadsheet 105
Word-Processor 78
Copyling File(s) 135
Counting Words 73
CPM
Importing Documents 67
CP/M Discs 102

CSV Files
Address Book 118
Spreadsheet 102

Currency Symbol (Spreadsheet) 112
Current Cell 98
Cul Sclection to Scratchpad

Spreadsheet 10$
Word-Processor 78
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D

Date, Setting 13
Date Format
Spreadsheet 113
Word-Processor 96
Day + / Day -. See Using the Diary
Decimal Character (Spreadsheet) 112
Default File Storage 137
Default Numeric Format 112
Default Text Format 112
Deflining Numeric Formats 111
Delete Appolntment 129
Delete Cell Contents 106
Delete Entry (Address Book) 121
Delete Selection
Word-Processor 78
Deleting File(s) 136
Deleting Fonts 56
Deskjet Printer 152
Desktop
Introduction 17
Desktop Sctup 54
Calendar 123
Diary / Alarm 36
DIF Files 102
Disc 19, 41, 157
Backup 44
Format 158
Discs
Folders 139
In the Word-Processor 64
Display Grid-Lines 110
DOS Discs 102
DOS filenames 157
Dot-Matrix Prioters 152
Draft option (Printing) 75
Drop-Lists
with the Mouse 49
Drum Counter
OKI Printer 55

Duplicatiog Discs 142
E

Edit Appointment 129
Edit Cell Contents 105
Editing a Stored Document 65
Editing a Stored Spreadshect 102
Emulation

Printer 150
Epson Stylus Printer 152
Export

Address Book 119
Exporting a Spreadsheet 103
Expressions (Spreadsheet Formulae) 114
Exterual Programs 53
Extra Characters 156

F

Flle Manager 131
File Size 132
File Type Indicator 132
Filenames 43
in DOS 157
Fill Across 107
Fill Dowa 107
Find Entry (Address Book) 121
Find Text
Spreadshect 109
Word-Processor 80
First-Line lodent 93
Floppy Disc 133. See also Disc
Floppy Discs 19
Focus in Dislogs 153
Folder Names 42
Cabinct 140
Disc 142
Folders 41
In the Wond-Processor 64
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Fonts Insert Name/Address 86
Installing and Deleting $6 Insert Row (Spreadsheet) 108
Size and Style 90 Inscrt Stored Phrase 85

Footers 70 Insert Time

Formatting Discs 142 Spreadsheer 108

Formula (Spreadshect) 99 Word-Processor B6

Functions in Spreadsheet formulae Installing Fonts 36

14 Italic 62, 89

G !

Go to Cell 109 Justified Text 93

Go to Date... 126 K

Groups (CP/M) 103

H Keyboard

Connecting 11
Headers and Footers 70

Editing 71 L
Printing Oplions 70 Laser Printers 15]
Help 19 Left-Aligned Text 93
Hot-Keys 47 Left-Handed 55
I Line Spating 93
List Order (File Mannger) 138
Import (Address Book) 117 Lists
Importing a Spreadsheet 102 in Dialogs
Importing Docomeats 66 with the Mouse 48
Inches. See Measuring Units Locoscript Documents 67
Indenting a Paragraph 89 M
Indents 60, 93
lokjet Printers 151 Mail-Merge
Insert / Overwrite 85 Codes 8B
Insert Calculation Printing 76
Spreadsheet 108 Making a New Template 72
Word-Processor 86 Manual 18
Insert Charscter 87 Margins 69
Insert Column (Spreadsheet) 108 Maich Case Option 81
Insert Date Mathematical Functions & Formulac 114
Spreadsheet 108 Measuring Units 69, 96
Word-Processor 86 Menus and Commands 46
Insert Document 85 with the Keyboard 47
Insert Mail-Merge Code 88 Millimctres. See Measuring Units
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Month + / Mooth -, See Using the
Diary

Mouse
Cleaning 147
Connecting 11
Introduction 14
Options 54

Moviang File(s) 138

Moving the Cursor
Spreadsheet 99
Word-Processor 57

N

Numbers, Aligning in Columns 90
Numeric Format 111

O

Operating System 56
Operators in Spreadsheet formulae
114
Options
Diary 129
Options Boxer 49
Overwrite Mode 85

P

Page Numbering 71
Paper Size 68
Paper Thickness
OKI Printer 55
Paragraph Format 92
Paragraph Style
Creating 95
Paragraph Siyles 61
Edning 94
Using 93
Paste from Scratchpad
Spreadsheet 105
Word-Processor 78
PCW, Older Models 67

Percent Button (Calculator) 40
Phrases
Inserting 8%
Storing 79
Point Stze 90
Point Sizes 63
Positioning your PcWIi6 9
Preferences .
Word-Processor 96 .
Print Density
OKI Printer 55
Print Preview :
Spreadsheet 104
Word-Processor 75
Printer
Coanecting 12
Sclecting 16
Printers 150 |
Dot-Matrix 152
Inkjet 151
Laser 151
Printing a Document 75
Printing a Spreadsheet 104

Q

Quality option (Printing) 75
R

Re-Paginating » Document 74
Recalcolate Now 103
Remove Column 106
Remove Row 106
Renaming Files 136
Repent Options (Diary) 128
Replace Text 82
Resolution
Printing 150
Restoring the Cabinet from Disc 141
Return Characters
Displaying 84
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Revert to Saved
Spreadsheet 102
Word-Processor 66

Rich Text Format
Expornting 68
Importing 66

Right-Aligned Teat 93

Rows (Spreadsheet) 97

RTF. See Rich Teat Format

Ruler 60

Run External Program 53

S

Safety Advice 9
Save and Continue 53
Save As...

Spreadsheet 102
Word-Processor 65
Saving your Work 41
Screen Saver 20, 56

Scroll Bars 48
Select Column 106
Sclect Row 106

Select Whole Spreadsheet 106
Selecting Files (File Mznager) 134

Selecting Text 59, 83
Set Margins 69

Set Mouse Options 54
Sct Paper Size 68

Set Print Options (Spreadsheet) 104

Set Startup Options 54
Set System Options 56
Setting the Clock 13
Setup Menu (Desktop) S
Shift Key 15
Show Day 127
Show Next Appt 126
Show System Folder
Cabinet 138
Disc 139

Show Today 126
Show Week 127
Size of Text 63
Space Above (Parsgruph) 93
Space Bar

in dialogs 153
Space Below (Paragraph) 93
Spaces

Displaying 84
Spell-Checker 73
Spinner Buttons 38
Spreadsheet 97
Standhy Button 12
Starting a New Document 64
Starting a New Spreadshect 101
Startup Options 54
Storing Phrases 79
Style Options 62
Subscript 91
Superscript 91
Switching OfT 17
System Folder 48, 138, 159
System Options 86

T

Tab key
in dialogs 153
Tabs 60
Changing 91
Displaying 84
Tasks Menu 53
Template
Creating 72
Including the Document Text 72
Using 63
Text Size 63
Text Style 89
Text Style Options 62, 90
Three-inch PCW discs 67
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Time Format
Spreadshect 113
Word-Processor 96

Time, Sctting 13

Typing 26, 57, 156

U

Underline 62, 89
Units and Measuring 69
Update Operating System $6
Use Larger/Smaller Font 89
User Dictionary

Adding Words 74
Using the Diary 124

w

Wake up from Standby 130

Week +/ Week -. See Using the Diary
Word Coont 73

Word Processor 57

Y
Year +/ Year -. See Using the Diary
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